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Before You Begin

Welcome to the COMSOL Multiphysics Installation Guide, which provides 
instructions on how to install COMSOL Multiphysics® and its add-on products. 
In addition to this manual, several online resources are available which are relevant 
for installation:
• System Requirements: www.comsol.com/system-requirements
• Support Knowledge Base: www.comsol.com/support/knowledgebase
• Support Center: www.comsol.com/support
• COMSOL Software License Agreement: www.comsol.com/sla
• Product Download: www.comsol.com/product-download
• Product Updates: www.comsol.com/product-update
• COMSOL Video Gallery: www.comsol.com/videos
• Learning Center: www.comsol.com/support/learning-center

Instal lation Media Options

There are four installation media options for COMSOL 6.4:
• Installation over the internet:

- This option requires internet access from the computer where COMSOL is 
to be installed.

• Installation from a downloaded DVD or DMG image:
- This option requires internet access from any computer for downloading the 

DVD image file (.iso file extension, for Windows® and Linux®) or DMG 
image file (.dmg file extension, for macOS).

• Installation from a DVD given to you by a COMSOL representative:
- This option requires access to a DVD reader on the computer where 

COMSOL Multiphysics is to be installed.

• Installation from a USB Flash Drive given to you by a COMSOL 
representative:
- This option requires a USB port on the computer where COMSOL is to be 

installed.

Installation using any of these four options is explained later in this document.
 | 9

https://www.comsol.com/system-requirements
https://www.comsol.com/support/knowledgebase
https://www.comsol.com/support
https://www.comsol.com/sla
https://www.comsol.com/product-download
https://www.comsol.com/product-update
https://www.comsol.com/videos
https://www.comsol.com/support/learning-center


System Requirements

COMSOL Multiphysics is a cross-platform software that runs on the Windows®, 
macOS, and Linux® operating systems. A variety of hardware platforms are 
supported, including graphics cards. Before installing, make sure your computer 
meets the current requirements listed at: www.comsol.com/system-requirements.
The system requirements page also lists compatible software versions for:
• External function C compiler
• COMSOL API when used with Java®

• LiveLink™ for MATLAB®

• LiveLink™ for Simulink®

• LiveLink™ for Excel®

• CAD Import Module
• Design Module
• LiveLink™ for SOLIDWORKS®

• LiveLink™ for Inventor®

• LiveLink™ for AutoCAD®

• LiveLink™ for Revit®

• LiveLink™ for PTC® Creo®Parametric™
• LiveLink™ for Solid Edge®

• File Import for CATIA® V5

Previous Instal lations

Previous installations of COMSOL are not affected by your new COMSOL 6.4 
installation, except that double-clicking a Model MPH file will open it in the latest 
installation (unless otherwise specified). You can continue to use other versions or 
uninstall them independently of the latest installation.

In this guide, the term COMSOL 6.4 refers not only to 
COMSOL Multiphysics 6.4 but also to any of the add-on 
products, as well as COMSOL Server 6.4 and its add-ons.
10 | 
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Software License Agreement

For the complete software license agreement with details on the license 
conditions, please refer to the COMSOL Software License Agreement. The PDF 
can be downloaded at www.comsol.com/sla. The license agreement is also 
available in your installation folder.
• On Windows, it is located at:

C:\Program Files\COMSOL\COMSOL64\Multiphysics\doc 
\pdf\COMSOL_Multiphysics\COMSOL_SoftwareLicenseAgreement.pdf

and can also be accessed from the Windows Start menu, under 
COMSOL Multiphysics 6.4 > COMSOL Documentation.

• On macOS, it is located at:
/Applications/COMSOL64/Multiphysics/doc/pdf/COMSOL_Multiphysics/
COMSOL_SoftwareLicenseAgreement.pdf

• On Linux, it is located in the installation directory, for example:
/usr/local/comsol64/multiphysics/doc/pdf/COMSOL_Multiphysics/
COMSOL_SoftwareLicenseAgreement.pdf

License Types

There is a variety of license options, and the steps involved when installing can 
differ depending on which license type you have acquired. No license type restricts 
usage to just one operating system but you are able to choose to install on either 
Windows, macOS, or Linux. A COMSOL Multiphysics model file saved on one 
platform can be opened on another. Certain license types come with restrictions; 
make sure you know which license type you have before proceeding with the 
installation.

All COMSOL licenses allow for multicore/multiprocessor 
shared-memory computing. How many cores or processors you 
can utilize is only limited by your hardware configuration and 
operating system. You can control the number of cores and 
processors in use from the Computing > Multicore page in the 
Preferences window.
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COMSOL MULTIPHYSICS

The following is an overview of the license types for COMSOL Multiphysics:

Named Single User License (NSL)
The COMSOL Multiphysics software may be installed and operated on up to four 
(4) individual computers, provided it is only accessible to, and operated by, a 
single licensed user designated by us as the Named User for that license and 
provided that the Named User may concurrently use the software on only two (2) 
of those computers at any given time. For each computer, there is no restriction 
on the number of simultaneous sessions that the Named User may run.

Locked Single User License (CPU)
You can install the COMSOL Multiphysics software on one designated computer 
and different users can take turns using the software on that computer, one user 
at a time. There is no restriction on the number of simultaneous sessions that the 
one user may run. The CPU version of the software may not be accessed or used 
over a network or remotely.

Floating Network License (FNL)
Licensed per concurrent user, you can install the software on as many machines on 
your network as needed within your country or territory. The COMSOL 
Multiphysics software can run on local computers, with the network used only for 
license authentication. Alternatively, you can run the software on a remote 
computer over your network. Support for remote computing includes using 
Windows® Remote Desktop. In addition, this license type allows access to the 
COMSOL computational engine using a client. For example, you can run the 
graphical user interface on an inexpensive local machine, while offloading the 
heavy computations to a remote high-end machine. Cluster and cloud computing 
is supported on Windows® and Linux® platforms. For local use, there is no 
restriction on the number of simultaneous sessions for one concurrent user. With 
respect to cluster computing and cluster sweeps, a single model may be run on 
multiple compute nodes with no restriction on the number of compute nodes.

Class Kit License (CKL)
Up to 30 teachers and students can run the software for classroom purposes over 
the school’s network where they access the license on-campus or through a secure 
remote connection.

For a full description and definition of the different license types, 
see the COMSOL Software License Agreement. All of the license 
types may not be available in your region.
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COMSOL COMPILER

The COMSOL Compiler is available under the following license types: Named 
Single User License (NSL), CPU-Locked Single User License (CPU), and 
Floating Network License (FNL). All those license types are described in the 
section above on COMSOL Multiphysics.

COMSOL SERVER

The following is an overview of the license types for COMSOL Server:

COMSOL Server License (CSL)
Licensed on a concurrent user basis. Each concurrent user may run up to four 
concurrent applications. The CSL version of the software enables you to run 
applications built with the Application Builder. The CSL allows you to host and 
run those applications within your organization and also to those outside your 
organization who time share your concurrent user slots, worldwide. Applications 
can be accessed through a major web browser on a variety of operating systems or 
a COMSOL client for the Windows® operating system. See www.comsol.com/
system-requirements for detailed requirements.

Academic Server License (ASL)
Licensed on a 300 concurrent user basis, each concurrent user may run up to four 
concurrent applications. The ASL version of the software enables you to run 
applications built with the Application Builder. The ASL allows you to host and 
 | 13
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run those applications for students, faculty, and staff of your academic institution 
or of any other academic institution, worldwide.

License Management Tools

The FlexNet® License Manager Software
Depending on your region and operating system, any of the above license types 
may require that the FlexNet® license manager software is installed and started 
before running a COMSOL product. The FlexNet® license manager is bundled 
with any COMSOL installation. You can view the contents of the license file 
(license.dat) that you received from your COMSOL representative by opening 
it with a text editor. If the file contains a line starting with the word SERVER, the 
license manager is required. For a Floating Network License, the purpose of the 
license manager is to count the number of concurrent users and to give an error 
message if the number of users exceeds the licensed number of concurrent users. 
Depending on your region and operating system, the license manager might also 
be needed for a Single User License. In that case, the purpose of the license 
manager is to lock the COMSOL session to a COMSOL authorized computer. 
See License Manager Installation on Windows for more information. The 
COMSOL software products and the license manager can be installed in any 
order, except if you are installing based on a port number and hostname. In that 
case, the license manager software needs to be installed and started before 
installing COMSOL.
We recommend that you use the license manager bundled with COMSOL 6.4. 
Using a license manager bundled with earlier COMSOL versions might work, but 
we recommend that you use the license manager from the latest COMSOL 
version. Use the license manager from the latest COMSOL version also for earlier 
COMSOL versions if possible. See the www.comsol.com/system-requirements 
for detailed requirements.
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Dongle Hardware Lock
Depending on your region and operating system, any of the above license types 
might require a dongle (hardware lock). If you have received a dongle to use with 
COMSOL, please refer to instructions given to you by your COMSOL 
representative.

COMSOL Access

COMSOL Access is a service provided by COMSOL that gives you access to 
additional content on www.comsol.com and allows you to:
• Download products
• Update products (restricted to customers with an active subscription)
• Edit contact and license information
• Access the Knowledge Base (unabridged access to all parts is restricted to 

customers with an active subscription)
• Contact technical support
• Manage event registrations
• Manage abstract submissions to the COMSOL Conference
• Access to the COMSOL Exchange online model sharing
• Participate in the Community Discussion Forum

Registering with COMSOL Access is required for product download and 
installation.
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Installing on Windows

Instal lation over the Internet

INSTALLATION OF A TRIAL LICENSE OVER THE INTERNET

A trial license can be given to you with the intention to test the software without 
any payment obligation for noncommercial and nonproduction use. This option 
is not available in all regions.
Installation of a Single User Trial License requires a license passcode. A passcode 
has a form similar to:

9FFF3FFFF7F5-TYUS-140917-17074436-384661755

This is usually sent to you by a COMSOL representative by email. Once you locate 
your passcode, follow these steps to prepare for download and installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.

2 If you have not already created a COMSOL Access account, you are prompted 
to create it. When you have created the account, you can enter your license 
passcode to associate it with your account information.
If you already created a COMSOL Access account, you can associate the license 
file with your account on the COMSOL Access page under Manage Licenses at 
www.comsol.com/access/licenses.

3 Follow the web-based instructions to download the software.
4 Continue with the instructions in the section Downloading and Installing the 

COMSOL Software.

A license passcode can also be used for class kit licenses (CKL).

INSTALLATION OF A PAID-FOR LICENSE OVER THE INTERNET

Installation of any paid-for license on Windows requires a license file that is sent 
to you by your COMSOL representative by email. To be able to generate the 
license file, information about your hardware is needed in the form of a hostid 
(host ID). The hostid is used to lock the license to your hardware and needs to be 
sent by you to a COMSOL representative prior to the license file being generated.
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Obtaining the Hostid
Follow these steps to obtain a hostid:
1 Open the Windows Command Prompt (cmd).
2 At the command line, type ipconfig /all and press Enter. The output should 

look similar to this:

3 The hostid you are looking for is here called Physical Address, also known as 
Ethernet address or MAC address.

Obtaining the Hostname
If you have been informed by your COMSOL representative that you need to run 
a license manager for your installation, then you also need the Host Name (see the 
screenshot above). If your network administrator prefers to use a fixed IP address 
for this particular computer, that IP address can be optionally used in place of the 
Host Name. For more information on license manager installation see License 
Manager Installation on Windows.

Hostid for PCs with Wireless Adapters
If you plan to install on a computer with a wireless network adapter, you need the 
physical address of both the wireless and the Ethernet adapter. 
If the COMSOL representative asks you for the hard disk serial number instead of 
the hostid, type vol at the Windows command line prompt. The output should 
look similar to this:

Volume Serial Number is 2C9F-5930

Obtaining the License File from a COMSOL Representative
Send the hostid information, as well as hostname, if applicable, in an email to your 
COMSOL representative, who responds with an email including an attached 
license file (license.dat). Save this file to any location on your computer. You 
need to refer to it during installation. 
The license file is a text file and below is an example of the contents of a 
license.dat file for a Single User License on Windows. In this example, the 
licensed products are COMSOL Multiphysics, Particle Tracing Module, 
Subsurface Flow Module, and LiveLink™ for Excel®.
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#------------------------------------------------------------------
# COMSOL 6.4 NSL License No: 1234567 Windows/Mac
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
FEATURE SERIAL LMCOMSOL 6.4 permanent uncounted \

VENDOR_STRING=C,18000100200 HOSTID=ANY sort=100 \
SN=1234567 TS_OK SIGN=8045890A6FE4

FEATURE COMSOL LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc" PLATFORMS="x64_n x64_mac arm64_mac" \
SN=2076312 SIGN=E607EB680852

FEATURE PARTICLETRACING LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc" PLATFORMS="x64_n x64_mac arm64_mac" \
SN=2076312 SIGN=3835733C6290

FEATURE SUBSURFACEFLOW LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc" PLATFORMS="x64_n x64_mac arm64_mac" \
SN=2076312 SIGN=3A9BA162C9E4

FEATURE LLEXCEL LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc" PLATFORMS="x64_n x64_mac arm64_mac" \
SN=2076312 SIGN=EE9C11E44356

FEATURE COMSOLGUI LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc" PLATFORMS="x64_n x64_mac arm64_mac"\
SN=2076312 SIGN=0D0A83382550

A Single User License file can normally not be edited in any way by the user and 
has to be identical to the one sent to you by a COMSOL representative. If you 
were sent a license file that requires a license manager, then minor edits are 
required. For information on the type of license file required for installations using 
a license manager, see The License File and The License Features.

Registering with COMSOL Access
Once you have saved your license file, follow these steps to register or login to 
COMSOL Access to start the installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.

2 If you have not already created a COMSOL Access account, you are prompted 
to create it. When you have created the account, point to your license file 
(license.dat) to associate it with your account information.
If you already have a COMSOL Access account, you can associate the license 
file with your account under Manage Licenses at www.comsol.com/access/
licenses.

3 Continue with the instructions in the next section.
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Downloading and Instal l ing the COMSOL Software

1 Go to the web page www.comsol.com/product-download. To download the 
COMSOL installer, you must first create a COMSOL Access account as 
described in the section Installation over the Internet.

2 You are now given the options of downloading the COMSOL online installer 
or the COMSOL offline installer (an ISO image).

STARTING THE ONLINE INSTALLER FOR INSTALLATION OVER THE INTERNET

Start the COMSOL Installer by running the downloaded file COMSOL64_win.exe. 
The COMSOL 6.4 Installer window should now appear. Next, continue with the 
instructions in the section Running the COMSOL Installer.

INSTALLATION FROM DOWNLOADED ISO IMAGE

1 Download the ISO image. The default image, COMSOL64_dvd.iso, is too large to 
burn to disc. For installations that require physical discs, download the files 
COMSOL64_dvd_1.iso, COMSOL64_dvd_2.iso and COMSOL64_dvd_3.iso instead.

2 If you have downloaded the single ISO image, you will need to mount it 
directly. In all supported Windows versions, this can be done by right-clicking 
the ISO image, selecting Mount and then continuing with the installation as if 
the files were on a DVD. If you have downloaded the split ISO images, you will 
need to burn them to discs. In all supported Windows versions, you can burn a 
disc by right-clicking the ISO image and selecting Burn to disc.

INSTALLING FROM A DVD OR MOUNTED DVD IMAGE

Once you have inserted the COMSOL DVD into the DVD drive (or mounted the 
image), the COMSOL Installer window should appear automatically; if not, run 
the file setup.exe on the installation DVD. The COMSOL 6.4 Installer window 
should now appear. Now continue with the instructions in the section Running 
the COMSOL Installer.

If you have problems downloading (such as Error downloading file. 
Connection refused: connect), please review this knowledge base 
entry: www.comsol.com/support/knowledgebase/1149. If you 
still have problems, contact your local COMSOL representative or 
technical support: www.comsol.com/support.
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Instal lation from a USB Flash Drive

If you have received a USB Flash Drive from a COMSOL representative, insert the 
USB Flash Drive into a USB port on your computer. The COMSOL Installer 
window should appear automatically; if not, run the file setup.exe on the USB 
Flash Drive. The COMSOL 6.4 Installer window should now appear. Now 
continue with the instructions in the section Running the COMSOL Installer.

Running the COMSOL Instal ler

The steps for running the COMSOL Installer are independent of the installation 
media. Once the installer has started, continue with the instructions in this section.

LANGUAGE PAGE

1 Select your language for the installation and click Next. You might also need to 
install fonts for the languages that you want to use when running COMSOL.
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MAIN PAGE

2 In the COMSOL Installer, select one of the following options:
- Click New COMSOL 6.4 Installation and proceed to Step 3 (License Page).
- Click Add/Remove Products and Reinstall and proceed to Step 5 (Platform 

Page) to change or repair an existing installation. For example, use Add/
Remove Products and Reinstall to add or remove documentation files for 
installed products, or to add or remove a product that your license includes.

- Click Change License and proceed to Step 3 (License Page) to update the 
license of an existing installation. Use this option when COMSOL is installed 
and you get a new license file. The installer will remove products not licensed 
any more and let you go through the Add/Remove Products procedure to 
add or remove products for the new license. If your trial license has expired, 
you can use the Change License option to reenable a paid license.

- Click Uninstall COMSOL 6.4 to remove an existing installation. For instructions 
on this option, see Removing (Uninstalling) the COMSOL Installation.

You can specify the path of an existing installation by pressing F1.
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LICENSE PAGE

3 For a new installation or a license change, the following is displayed:

After reading the license agreement, click the I accept the terms of the license 
agreement button and specify the license. Choose one of the following license 
formats from the License format list, depending on which license you have:
- Passcode: Use this option for a Single-User Trial License or Class Kit License. 

Enter your passcode, which is a case-sensitive series of characters and numbers 
with a form similar to FFFFFFFFFFFF-TYUS-123456-1234567-123456789.

- License file: Use this option for any type of regular paid-for license installation. 
Enter the path to a license file or click Browse to select the file license.dat. 
This file is sent to you by a COMSOL representative, typically by email.

- Port number and Hostname: Use this option if your license administrator has 
given you a port number and hostname for a license manager for COMSOL 
that is running on your organization’s network. Enter the Hostname of the 
server running the license manager and its license manager port number.

- Three-server redundancy: Use this option if your license administrator has 
given you three port numbers and hostnames for the three-server redundancy 
license manager option. Enter the hostnames and license server port numbers 
of the three-server redundant configuration.
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Change License
If Change License was selected in Step 2, first select Use current paid license, to use 
an existing license, or Specify new license, to use a new license, from the License list.

Click Next and proceed to Step 5 if you want to change to a license with different 
products. Otherwise, proceed to Step 10.
4 Click Next.
You can also automate a license change. If you specify a new license in 
setupconfig.ini and set installdir to an existing comsol installation directory 
(the installed version must match the version of the setup program), the installer 
will use the new license and add or remove products as needed to match the new 
license. See the description of the Installer Mode inside the setupconfig.ini file.
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LICENSE NUMBER PAGE

This page only appears if you have a license file corresponding to several different 
licenses (a so-called merged license file). From the list of license numbers, select 
the one you want to install. Both COMSOL Multiphysics licenses and COMSOL 
Server licenses can appear here. The license number you choose will determine 
which products are available on the next page.
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PRODUCTS PAGE

5 Select the COMSOL products to install, which applications and documentation 
to install, and specify the path to the COMSOL installation folder.
All products that your license includes are selected by default.

The License Manager checkbox is also selected. Depending on your region and 
operating system, the license type may require that the license manager is 
installed and started before running COMSOL (see License Management 

For more information about installing and configuring the CUDA 
Toolkit for use with COMSOL Multiphysics, see: 
www.comsol.com/learn/cudatoolkit.

For more information about setting up the Chatbot functionality, 
see: www.comsol.com/learn/chatbot.
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Tools). In some cases, however, the license manager is installed automatically 
during the COMSOL installation.
From the options under Application libraries, choose one of the following:
- Install application libraries for selected products (the default) to install the 

application libraries for the licensed products that you have selected.
- Install application libraries for all products to install the application libraries for 

all COMSOL products.
- Install application library previews for selected products to install previews of 

the application libraries for the licensed products that you have selected.
- Install application library previews for all products to install previews of all 

application files in the application libraries for all COMSOL products.
- Do not include application libraries to not install any application libraries. 

Selected applications can be downloaded via Application Library Update.

From the options under Documentation, choose one of the following:
- Install documentation relevant to selected products (the default) to install the 

documentation for the licensed products that you have selected. For some 
products, documentation for other relevant products is also installed, so that 
you get access to documentation for functionality included in the licensed 
products but covered in other products’ documentation.

- Install documentation for all products to install the documentation for all 
COMSOL products. You can then view and search all COMSOL 
documentation, even for products not included in your license.

- Online documentation only to not install any documentation. You can still view 
documentation and access context help using online documentation provided 
by COMSOL, but no documentation files are installed on your computer.

Under Destination folder, a default installation destination is suggested; for 
Windows, typically C:\Program Files\COMSOL\COMSOL64\Multiphysics. Click 
Browse or type another destination directory if needed.

If Change License was selected earlier (for an existing installation), 
make sure that all the relevant product checkboxes are selected. If 
the new license adds products that were not included in the 
original installation and the checkboxes for those products are not 
selected, the license information will be correct but the software 
components needed to use the products will be missing.
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Add/Remove Products and Reinstall
- If Add/Remove Products and Reinstall or Change License was selected in Step 2, 

the Products page includes a Reinstall selected and installed products 
checkbox. Select this to reinstall selected products that are already installed.

- The options for application libraries and documentation can also be changed. 

6 Click Next.

You can also add, remove, and repair COMSOL products from 
the installed instance by running the setup executable in the 
installation directory. If needed, the installer can either download 
the files from the internet or use the original DVD (or disk image).
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OPTIONS PAGE: FIRST SECTION

7 On this page, you can set the following installation options:
- Create COMSOL Multiphysics 6.4 shortcuts on Windows Desktop.
- Create COMSOL Multiphysics 6.4 folder on Windows Start Menu.
- Add Windows Firewall rules for COMSOL programs. This checkbox adds firewall 

rules that allow COMSOL server programs to open ports and communicate 
over the network. If you clear this checkbox, you might get a warning from 
the Microsoft Firewall when you start a COMSOL server program, or a 
COMSOL server program might not work as expected.

- Configure security policy. If you select this option, a later page in the installer 
provides security options that you can either set permanently or as user 
defaults; see Security Page. If you set a permanent security policy, the security 
settings in the Preferences window will be read-only.

- If you want to use a proxy server, specify the hostname, port number, and, if 
required, a username and password. If you do not enter a port number, the 
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installer will use port 443 (the default port for the HTTPS protocol.) These 
settings do not appear for offline installation methods.

The following options are available under Update:
- Check for updates after installation. This option is selected by default. The 

installer will apply all available updates (if any) for the installed version.
- Enable automatic check for updates. Select this checkbox if you want 

COMSOL to automatically check for available product updates at startup.
- Enable automatic check for new releases. Select this checkbox if you want 

COMSOL to automatically check for new full releases at startup.
- By default, COMSOL 6.4 uses an included Java 21 runtime, indicated by the 

Built-in setting in the Java runtime environment list. If you want to run 
COMSOL with another Java 21 runtime that you have licensed and installed, 
specify its location in the Location field by first choosing Custom.

The CUDA and cuDSS sections are available in the case that GPU Compute 
Components was selected on the Products page, but NVIDIA CUDA® Toolkit and/
or NVIDIA CUDA® Direct Sparse Solver were not.
- If a compatible NVIDIA CUDA® Toolkit is already installed on the system, 

specify the installation directory in the Custom CUDA directory field to enable 
GPU hardware acceleration. This path can also be changed on the Computing 
> GPU Acceleration page in the Preferences window. For more information 
about installing the CUDA Toolkit for use with COMSOL Multiphysics, see 
www.comsol.com/learn/cudatoolkit.

- If a compatible NVIDIA CUDA® Direct Sparse Solver library is already 
installed on the system, specify the installation directory in the Custom cuDSS 
directory field to enable the GPU-accelerated direct sparse solver. This path 
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can also be changed on the Computing > GPU Acceleration page in the 
Preferences window.

- Non-Latin (Asian) language installations have the option to select a different 
default font family, such as one that has an appropriate set of Asian characters.

8 Click Next.
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OPTIONS PAGE: SECOND SECTION

9 On this page, you can set the following installation options:
- Associate the .mph file type with this installation. If this checkbox is selected, 

you can open COMSOL models by double-clicking them.
- Associate links in the Model Manager server web interface with this installation. 

If this checkbox is selected, you can open COMSOL models directly from the 
web interface of a Model Manager server.

- For the interface for Microsoft PowerPoint®, which makes it possible to 
interactively update PowerPoint presentations with COMSOL images and 
tables, choose Install for the current user, Install for all users, or Do not install.

- For the interface for Microsoft Word®, which makes it possible to 
interactively update Word documents with COMSOL images and tables, 
choose Install for the current user, Install for all users, or Do not install.
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10 Click Next.

Custom Java 21 runtimes must be OpenJDK based and of at least 
the same minor version as the built-in one. If the runtime includes 
a subset of JDK modules, at least the following must be included:

• java.*

• jdk.accessibility

• jdk.attach

• jdk.charsets

• jdk.crypto.*

• jdk.dynalink

• jdk.httpserver

• jdk.javadoc

• jdk.jdi

• jdk.jdwp.agent

• jdk.jshell

• jdk.jsobject

• jdk.localedata

• jdk.management

• jdk.naming.*

• jdk.net

• jdk.nio.mapmode

• jdk.random

• jdk.sctp

• jdk.security.*

• jdk.unsupported

• jdk.xmld.dom

• jdk.zipf
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LIVELINK PAGE

11 The LiveLink page contains installation settings for the LiveLink™ products:
- Install LiveLink™ for Excel® for all users. If you select this checkbox, the 

installation of LiveLink™ for Excel® is global to the machine and is available 
no matter which user is logged on. Otherwise, the installation is only available 
to the current user.

- For the products LiveLink™ for MATLAB® and LiveLink™ for Simulink®, 
specify the path to the MATLAB installation folder. This path can be changed 
on the LiveLink Connections page in the Preferences window.
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LICENSE MANAGER PAGE

12 The License Manager page appears if the License Manager was selected on the 
Products page and your computer is designated to be the license server. If this 
page does not appear, you can manage the license server using LMTOOLS; see 
Starting the License Manager. This page contains the following options:
- The Install license manager as a Windows service checkbox is selected by 

default; if you clear the checkbox, the license manager must be started 
manually and will not be available as a Windows service.

- The Path to the debug log file field contains a file path to the location of the 
license manager debug log file. Click Browse to choose another file path.

- The Service name field shows the service name, for information only.
- The Additional license manager options section contains the following options:

Select the Allow the lmdown command to be executed only from this computer 
checkbox to restrict the access to the lmdown command, which you can use to 
shut down the license manager, to this computer only.
Select the Disable the lmdown command checkbox to make the lmdown 
command unavailable.
Select the Disable the lmremove command checkbox to make the lmremove 
command, which you can use to remove a user’s license, unavailable.
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SECURITY PAGE

13 The Security page appears if you selected the Configure security policy checkbox.
The COMSOL software includes security settings for controlling access to, for 
example, system properties, file systems, and runtime security settings from 
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methods and external libraries, primarily for use in applications created using 
the Application Builder. 
In the Security policy list, select User defaults (the default) or Permanent to 
control if the settings made on this page will be possible to change or set 
permanently after the installation is finished.
The following security settings are available in the General section (the top four 
checkboxes are selected by default):
- Select the Allow batch jobs checkbox to allow batch jobs. This restriction 

affects the Batch, Batch Sweep, Cluster Computing, and Cluster Sweep 
nodes in the COMSOL Desktop model tree.

- Select the Allow running methods checkbox to allow running applications that 
include methods. If you clear this checkbox, it is not possible to run methods 
in applications.

- Select the Allow running applications checkbox to allow running applications 
in general. If you clear this checkbox, it is not possible to run any applications.

- Select the Allow settings forms checkbox to allow settings forms and dialog 
forms in the Model Builder. If you clear this checkbox, an error message 
appears if you try to create a new settings form or show a dialog form.

- From the Allow external libraries list, select No (the default), Yes, or Ask to 
control if external C libraries can be called from methods in an application, 
either directly or by asking first.

- From the Allow external MATLAB® functions list, select No (the default), Yes, or 
Ask to control if functions written in MATLAB (requires LiveLink™ for 
MATLAB®) can be called, either directly or by asking first.

In the Methods and Java libraries section, the Enforce security restrictions 
checkbox is selected by default. The following settings are available for easing 
parts of the restrictions on methods and Java libraries (none selected by default):
- Select the Allow access to system properties checkbox to read and write system 

properties. For example, System.getProperty("cs.np") can be used to 
determine how many cores COMSOL Multiphysics is currently using.

- Select the Allow changes to the runtime system checkbox to allow methods and 
Java libraries to change the runtime system — for instance, by modifying class 
loaders.

- From the File system access list, select Temporary and application files (the 
default) to restrict methods and Java libraries to only have access to such files, 
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or select All files to allow methods and Java libraries to access all files that you 
have permissions to access on the file system.

- Select the Allow external processes checkbox to allow applications to start 
external processes on the computer. This includes using the built-in 
executeOS() method.

- Select the Allow access to network sockets checkbox to allow methods and 
Java libraries to open sockets for network access.

- Select the Allow control of the network authentication method checkbox to 
allow methods and Java libraries to control the network authentication 
method used.

- Select the Allow access to classes through reflection checkbox to allow access 
to all members in a class through reflection.

- Select the Allow access to runtime security settings checkbox to allow methods 
and Java libraries to access security settings.

- Select the Allow access to Model Manager databases checkbox to allow methods 
and Java libraries to access Model Manager databases, including both reading 
and writing data.

To allow methods and Java libraries to run with security completely disabled, 
clear the Enforce security restrictions checkbox and, in the General section, select 
the Allow external processes checkbox.
In the Internet section, select the Use a restrictive security policy for model files 
downloaded from the internet checkbox to use a restrictive security policy (Mark 
of the Web) for model and app files downloaded from the internet. In the 
Trusted sites section, you can add and remove internet sites that you want 
COMSOL Multiphysics to consider trusted when the restrictive security policy 
is enabled. By default, the list of trusted sites contains all the COMSOL 
Application Gallery web pages.

14 Click Next.
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INSTALL PAGE

15 When you click Install the utility will install or update COMSOL. The 
installation process can take several minutes. If you are installing over the 
internet, the installation time depends on your internet connection speed. The 
Finish page appears when the installation process is finished.
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FINISH PAGE

16 This window appears when the installation is finished.

If warnings or errors were detected, click View Log to open a window that shows 
the installation log. Contact technical support if you encountered any errors, 
and remember to send the log file along with your technical support inquiry.

17 Click Close to quit the installer.

For information on how to run COMSOL Multiphysics after installation, see 
Running COMSOL Multiphysics on Windows. If you are installing on macOS, 
see Running COMSOL Multiphysics on macOS. If you are installing on Linux, 
see Running COMSOL Multiphysics on Linux.

Removing (Uninstal l ing) the COMSOL Instal lation

To remove a COMSOL installation from your system, you can use the COMSOL 
Installer’s uninstallation option. The uninstaller deletes all COMSOL files and 
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directories on the system that were installed by the COMSOL installer. Additional 
files and folders created after installation are not removed.
If COMSOL Multiphysics is run with MATLAB, close MATLAB before starting 
the uninstaller. If MATLAB is active, the utility cannot remove certain files.
You can start the COMSOL Uninstaller in a few different ways:
• From the Windows Start Menu, open Settings and select Apps. Find 

COMSOL Multiphysics 6.4 in the list and select Uninstall.
• From the Windows Start Menu, under COMSOL Multiphysics 6.4, select 

COMSOL Launchers > Uninstall.
• Insert the COMSOL DVD and start the COMSOL Uninstaller. Click 

Uninstall COMSOL 6.4  to start removing the installation. Click Close to quit 
the installer when the uninstallation is complete.

Instal l ing Software Updates

COMSOL provides software updates that improve the software and correct issues. 
To check if an update is available, choose Check For Product Updates from the Help 
menu. To check for updates automatically each time you start COMSOL 
Multiphysics, select the Check for product updates at launch checkbox on the 
Updates page in the Preferences window. 
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If an update is available, an Update dialog appears. Click Direct Download to 
download the update directly, or click Product Information to open the COMSOL 
website where you can read about and download the update. When the update 
installation starts (close any running instance of COMSOL first) you see the 
following installation window:

If a COMSOL process is running when you start an update installation, you must 
instead first choose one of the following options:
• Cancel: Stop the update process.
• Try Again: Restart the update process (after closing all COMSOL processes.)
• Continue Anyway: Proceed with the upgrade, ignoring any running instances 

of COMSOL.

You can use Direct download (the default) or Download via proxy server. If you 
download via a proxy server, specify the hostname and port number for the proxy 
and, if required, a username and password.
When selecting Manual download, you point to a DAT-file that you download from 
www.comsol.com/product-update. This page contains details and options for 
manual download of the update.
Alternatively, you can launch the update installer without checking for updates 
from inside COMSOL Multiphysics. To do this, from the Windows Start Menu 
under COMSOL Multiphysics 6.4, select COMSOL Launchers > Update.
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AUTOMATED UPDATES

You can update the COMSOL software using an automated update process with 
minimal user interaction by using the previously mentioned DAT-file. Consult 
www.comsol.com/product-update for detailed instructions.

Automated Instal lation

You can install the COMSOL software using an automated installation process 
with minimal user interaction. This method requires installation from a DVD or 
DVD image and an answer file.
The answer file is a text file with a specific format that contains predefined settings 
for the COMSOL installer. If non-ASCII characters are used, the answer file is 
expected to be UTF-8 encoded by default, but UTF-16 is also supported if the 
file starts with a byte order mark (BOM).
A template answer file, setupconfig.ini, with detailed usage information is 
available on the DVD. Create a copy of this file and customize it with a text editor.
When the answer file is ready, start the installation by running
<path to DVD>\setup.exe -s <answer file path>

where <answer file path> is the full path to your answer file.

AUTOMATED REMOVAL (UNINSTALLATION) OF COMSOL
You can also uninstall COMSOL with an answer file by following these steps:
1 Edit the answer file and set installmode to uninstall.
2 Set installdir to the path of the installation you want to remove.
3 Run <path to COMSOL>\bin\win64\setup.exe -s <answer file path>

where <answer file path> is the full path to your answer file. If you are running 
this command in a command prompt (for example, cmd), make sure that the 
current working directory is outside the COMSOL installation directory.
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Product Updates and Library Updates

COMSOL periodically releases product updates with improvements and 
corrections to reported problems. By default, COMSOL Multiphysics does not 
check for updates at startup. You can activate this feature in the Updates page of 
the Preferences window.
The Application Libraries for the COMSOL products are updated on a regular 
basis by COMSOL. To open the Application Library Update window, from the File 
> Help menu (Windows users) or from the Help menu (macOS and Linux users), 
select Update COMSOL Application Libraries.
This connects you to the COMSOL Application Library Update website where 
you can access the latest updates. This includes files that have been added or 
improved since the latest product release.
In a similar way, you can also update the COMSOL Part Libraries. To open the 
Part Library Update window, from the File > Help menu (Windows users) or from 
the Help menu (macOS and Linux users), select Update COMSOL Part Libraries.

Using the Preferences window, you can set custom application and documentation 
directories for Application Library Update, a custom part directory for Part 
Library Update, and a custom add-in directory for Add-in Library Update. See the 
COMSOL Multiphysics Reference Manual for more information, including 
command-line options for the Application Libraries and Part Libraries.
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LiveLink™ for  Excel® Instal lations

If you have licensed LiveLink™ for Excel®, the installer registers an add-in with 
Excel. When the add-in is active, several tools for working with a COMSOL 
Multiphysics model from an Excel worksheet are accessible from a COMSOL tab 
in the Excel ribbon. You can, for example, extract model definitions and results. 
You can also change model definitions in the worksheet, then update and 
recompute the model.
Whenever you open a COMSOL Multiphysics model from Excel, a COMSOL 
Multiphysics server is started where the model is loaded. The data transfer between 
Excel and the COMSOL Multiphysics server application is performed using a 
TCP/IP communication protocol, which accepts only local connections.

LiveLink™ for  AutoCAD® Instal lations

If you have licensed LiveLink™ for AutoCAD®, the installer registers an add-in 
with AutoCAD. When the add-in is active a COMSOL Multiphysics tab appears 
in AutoCAD.
The add-in enables two modes of setting up simulations based on the AutoCAD 
design:
• In one mode you can run AutoCAD and the COMSOL Desktop 

side-by-side and synchronize the geometry between the two. This mode 
enables running parametric sweeps, as well as parameter optimizations using 
an optimization solver (available with a license for the Optimization 
Module).

• In offline synchronization mode you can save a synchronization file using 
the add-in inside AutoCAD. You can then load the synchronization file into 
the COMSOL Desktop running on a different computer from the CAD 
software. This mode enables single synchronizations and parametric sweeps.

If the COMSOL Multiphysics tab does not appear, run the 
COMSOL Installer to repair the installation (see 
www.comsol.com/support/knowledgebase/1221 for 
instructions).
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LiveLink™ for  Inventor® Instal lations

If you have licensed LiveLink™ for Inventor®, the installer registers an add-in for 
Autodesk Inventor called LiveLink for COMSOL (6.4). This add-in should 
appear in the Add-In Manager dialog that is accessible from the Options tab of the 
Tools panel in the Autodesk Inventor user interface.
The add-in provides tools for preparing your Inventor design for simulation with 
COMSOL Multiphysics. For example, you can set up dimensional parameters 
that, together with the geometry, are synchronized with the COMSOL 
Multiphysics model.
The add-in enables several modes of setting up simulations based on the Inventor 
design:
• In one mode you can run Inventor and the COMSOL Desktop side-by-side 

and synchronize the geometry between the two. This mode enables running 
parametric sweeps, as well as parameter optimizations using an optimization 
solver (available with a license for the Optimization Module).

• In another mode you can work with COMSOL Multiphysics simulations 
inside Inventor. This latter mode is called the One-Window interface.

• In offline synchronization mode you can save a synchronization file using 
the add-in inside Autodesk Inventor. You can then load the synchronization 
file into the COMSOL Desktop running on a different computer from the 
CAD software. This mode enables single synchronizations and parametric 
sweeps.

You can also install and register the add-in with AutoCAD by 
installing the COMSOL Client, available for download from 
www.comsol.com. Such an installation enables the functionality 
for preparing AutoCAD designs for synchronization, saving files 
for offline synchronization, and running simulation apps that 
synchronize geometry.

If COMSOL Multiphysics cannot connect to Inventor, run the 
COMSOL Installer to repair the installation, see 
www.comsol.com/support/knowledgebase/1221 for 
instructions.
 | 45

https://www.comsol.com
https://www.comsol.com/support/knowledgebase/1221


LiveLink™ for  PTC® Creo® Parametric™ Instal lation

If you have licensed LiveLink™ for PTC® Creo® Parametric™, the installer registers 
an add-in for PTC Creo Parametric called the LiveLink for COMSOL (6.4). This 
add-in should appear in the Auxiliary Applications dialog that is accessible from 
the Tools tab, Utilities group in the PTC Creo Parametric user interface.
The add-in provides tools for preparing your PTC Creo Parametric design for 
simulation with COMSOL Multiphysics. For example, you can set up dimensional 
parameters that, together with the geometry, are synchronized with the 
COMSOL Multiphysics model. You can access the functionality provided by the 
add-in on the COMSOL Multiphysics tab in the PTC Creo Parametric user 
interface.
The add-in enables two modes of setting up simulations based on the PTC Creo 
Parametric design:
• In one mode you can run PTC Creo Parametric and the COMSOL Desktop 

side-by-side and synchronize the geometry between the two. This enables 
running parametric sweeps, as well as parameter optimizations using an 
optimization solver (available with a license for the Optimization Module)

• In offline synchronization mode you can save a synchronization file using 
the add-in inside PTC Creo Parametric. You can then load the 
synchronization file into the COMSOL Desktop running on a different 
computer from the CAD software. This mode enables single 
synchronizations and parametric sweeps.

You can also install and register the add-in with Inventor by 
installing the COMSOL Client, available for download from 
www.comsol.com. Such an installation enables the functionality 
for preparing Inventor designs for synchronization, saving files for 
offline synchronization, and running simulation apps that 
synchronize geometry.

If COMSOL Multiphysics cannot connect to PTC Creo 
Parametric, run the COMSOL Installer to repair the installation 
(see www.comsol.com/support/knowledgebase/1221 for 
instructions).
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LiveLink™ for  Revit® Instal lations

If you have licensed LiveLink™ for Revit®, the installer registers an add-in for 
Autodesk Revit. When the add-in is loaded a tab called COMSOL Multiphysics 
appears in Revit. Here, you find tools for preparing your project for simulation 
with COMSOL Multiphysics. For example, you can select the architectural 
elements and rooms that will take part in the synchronization.
The add-in enables setting up simulations based on a Revit project by 
synchronizing geometry between Revit and the COMSOL Desktop when these 
are run side-by-side.

You can also install and register the add-in with PTC Creo 
Parametric by installing the COMSOL Client, available for 
download from www.comsol.com. Such an installation enables the 
functionality for preparing PTC Creo Parametric designs for 
synchronization, saving files for offline synchronization, and 
running simulation apps that synchronize geometry.

The COMSOL Multiphysics tab will not appear if the add-in 
cannot be loaded by Revit. This can happen if, for example, the 
COMSOL installation is moved to a different location. To restore 
the add-in run the COMSOL Installer to repair the installation 
(see www.comsol.com/support/knowledgebase/1221 for 
instructions).

You can also install and register the add-in with Revit by installing 
the COMSOL Client, available for download from 
www.comsol.com. Such an installation enables the functionality 
for preparing Revit projects for synchronization, and running 
simulation apps that synchronize geometry.
 | 47

https://www.comsol.com
https://www.comsol.com/support/knowledgebase/1221
https://www.comsol.com


LiveLink™ for  Sol id Edge® Instal lations

If you have licensed LiveLink™ for Solid Edge®, the installer registers an add-in for 
Solid Edge called LiveLink for COMSOL (6.4). This add-in should appear in the 
Add-In Manager dialog that is accessible in the Solid Edge user interface if you 
click the Applications button, and then select Add-Ins from the menu.
When the add-in is active a COMSOL Multiphysics tab appears in Solid Edge. The 
add-in enables two modes of setting up simulations based on the Solid Edge 
design:
• In one mode you can run Solid Edge and the COMSOL Desktop 

side-by-side and synchronize the geometry between the two. This enables 
running parametric sweeps, as well as parameter optimizations using an 
optimization solver (available with a license for the Optimization Module)

• In offline synchronization mode you can save a synchronization file using 
the add-in inside Solid Edge. You can then load the synchronization file into 
the COMSOL Desktop running on a different computer from the CAD 
software. This mode enables single synchronizations and parametric sweeps.

If COMSOL Multiphysics cannot connect to Solid Edge, run the 
COMSOL Installer to repair the installation (see 
www.comsol.com/support/knowledgebase/1221 for 
instructions), or manually register the add-in according to the 
steps from the following link “Error: Failed to connect to Solid 
Edge”:
www.comsol.com/support/knowledgebase/1160.

You can also install and register the add-in with Solid Edge by 
installing the COMSOL Client, available for download from 
www.comsol.com. Such an installation enables the functionality 
for preparing Solid Edge designs for synchronization, saving files 
for offline synchronization, and running simulation apps that 
synchronize geometry.
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LiveLink™ for  SOLIDWORKS® Instal lations

If you have licensed LiveLink™ for SOLIDWORKS®, the installer registers an 
add-in for SOLIDWORKS called LiveLink for COMSOL (6.4). This add-in 
should appear in the SOLIDWORKS user interface, listed in the Add-Ins dialog, 
accessible from the Tools menu.
The add-in provides tools for preparing your SOLIDWORKS design for 
simulation with COMSOL Multiphysics. For example, you can create selections 
on the geometry and set up dimensional parameters. Those selections and 
parameters, together with the geometry, are synchronized with the COMSOL 
Multiphysics model.
The add-in enables two modes of setting up simulations based on the 
SOLIDWORKS design:
• In one mode you can run SOLIDWORKS and the COMSOL Desktop 

side-by-side and synchronize the geometry between the two. This enables 
running parametric sweeps, as well as parameter optimizations using an 
optimization solver (available with a license for the Optimization Module).

• In offline synchronization mode you can save a synchronization file using 
the add-in inside SOLIDWORKS. You can then load the synchronization 
file into the COMSOL Desktop running on a different computer from the 
CAD software. This enables single synchronizations and parametric sweeps.

If COMSOL Multiphysics cannot connect to SOLIDWORKS, 
run the COMSOL Installer to repair the installation (see 
www.comsol.com/support/knowledgebase/1221 for 
instructions), or manually reregister the add-in by following the 
steps from the following link: www.comsol.com/support/
knowledgebase/1122.

You can also install and register the add-in with SOLIDWORKS 
by installing the COMSOL Client, available for download from 
www.comsol.com. Such an installation enables the functionality 
for preparing SOLIDWORKS designs for synchronization, saving 
files for offline synchronization, and running simulation apps that 
synchronize geometry.
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Cluster Instal lation

COMSOL Multiphysics supports two mutual modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support. This section is dedicated to distributed-memory parallel 
installation.
COMSOL Multiphysics can distribute computations on compute clusters using 
the MPI model. One large problem can be distributed across many compute 
nodes. Also, parametric sweeps can be distributed with individual parameter cases 
distributed to each cluster node.

PREREQUISITES

The cluster installation instructions assume that you have a fully operational and 
tested Windows cluster with the Windows Server 2016, Windows Server 2019, or 
Windows Server 2022 operating system and that you are a fully qualified system 
administrator, with administration access rights to the cluster head node and 
compute nodes. A compatible version of Microsoft® HPC Pack for your version 
of Windows Server is required.

LICENSE MANAGER

COMSOL Multiphysics requires a Floating Network License for running on 
clusters. Please check the license file for the CLUSTERNODE feature, which needs to 
be present to enable the cluster computing functionality. The license manager 
needs to be accessible from all nodes in the cluster. Therefore it is often a good 
idea to have it run on the head node.

INSTALLATION FOLDER

The COMSOL Multiphysics installation folder should be shared between all 
compute nodes and the head node. The installation of the COMSOL software is 
only needed on the head node. Alternatively, the software can be installed on C:\ 
on each compute node. Typically, the installation directory is accessed through a 
UNC (uniform naming convention) path on the Windows private network that is 
only seen by the compute nodes that belong to the cluster.

INSTALLATION PROCEDURE

In addition to the normal installation steps as outlined under Installing on 
Windows, this section includes specific information for cluster installations.
During installation, on the Products page (see Products Page) ensure that you 
select the COMSOL Cluster Components checkbox under Select products to install.
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For the installation directory that you specify in the Destination folder text field, 
remember to share the installation directory with the compute nodes after 
installation.
If you installed COMSOL Multiphysics on a shared directory, you need to install 
Microsoft Visual Studio® runtime libraries on each compute node. (See 
www.comsol.com/support/knowledgebase/1083 for instructions.)

ACCESS TO CLUSTER (WINDOWS SERVER ONLY)
If you work on a desktop PC, install COMSOL on that PC. Before you start, you 
need to install Microsoft® HPC Pack on the PC. This software is free and enables 
you to access the cluster from your PC.

CHECKING THE INSTALLATION

After the cluster installation has finished, make the following checks to make sure 
that the installation is working:
• Make sure that the COMSOL installation directory is shared between all the 

compute nodes and the head node on a shared network disk.
• Make sure that the license manager is reachable from all compute nodes.

- If you have firewalls activated, open any relevant TCP ports for the license 
check from the nodes.

- For more information, see www.comsol.com/support/knowledgebase/903
• To check that a node is OK, open a remote desktop session to the compute 

node, then start \\headnode\COMSOL\bin\win64\comsol.exe (assuming 
\\headnode\COMSOL is the shared installation directory). If the COMSOL 
Desktop starts without license errors, the license management works fine. If 
not, check the firewall (see above). If you get other errors, you may need to 
install runtime libraries on the compute nodes.

For more information on installing and running COMSOL Multiphysics on 
clusters, see Running COMSOL Multiphysics on Clusters and the COMSOL 
Multiphysics Reference Manual.
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License Manager Installation on Windows

Depending on your region and operating system, you might be required to install 
and run the FlexNet® license manager in order to run COMSOL Multiphysics.

What Is the FlexNet® License Manager?

COMSOL uses the FlexNet® license manager software for license management.
The license manager comes bundled with any COMSOL installation. The 
COMSOL software products and the license manager can be installed in any 
order, unless you are installing based on a port number and hostname. In that 
case, the license manager software needs to be installed and started before 
installing COMSOL. You should use the version of the license manager that is 
shipped with the newest version of COMSOL installed on your system.
Installation of any paid-for license on Windows requires a license file 
(license.dat), which is sent to you by a COMSOL representative by email. You 
can view the contents of the license file by opening it with a text editor or word 
processing software. If the file contains a line starting with the word SERVER, 
then the license manager is required. For a Floating Network License, the purpose 
of the license manager is to count the number of concurrent users and to give an 
error message if the number exceeds the licensed amount. Depending on your 
region and operating system, the license manager might also be needed for Single 
User Licenses. In that case, the purpose of the license manager is to lock a 
COMSOL session to a computer that is authorized by COMSOL.
The FlexNet® license manager software supports a heterogeneous network of 
Windows, Linux, and macOS computers. Both the license manager and the 
COMSOL software can run on either Windows, Linux, or macOS platforms. In 
this context, the computer where the license manager is installed is called the 
license server and any computer that has the COMSOL products installed is called 
a client. Any type of networked computer can function as a license server, such as 
a laptop, desktop, workstation, or centrally located server. COMSOL can be 
installed anywhere, typically on a local PC or on a server where users access the 
program over the network. A single computer can function as both license server 
and client, holding both the license manager and COMSOL.
Even though the license manager and COMSOL can be installed in any order, a 
full test of the installation cannot be done until both are installed.
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System Requirements for the FlexNet® License Manager

Before starting the installation process, check that your system meets all necessary 
requirements as listed at: www.comsol.com/system-requirements. If you are 
running the license manager on a license server where you do not intend to run 
the COMSOL software, the system only needs to meet the listed hardware and 
operating system requirements. The memory and graphics requirements do not 
need to be met because the license manager is not as resource intensive as the 
COMSOL software.

ABOUT MAC ADDRESSES

As licenses are based on MAC addresses, MAC address randomization is not 
supported.

FlexNet® License Manager Software Components

The license manager consists of four software components:
• License server manager (lmgrd.exe)
• Vendor daemon (LMCOMSOL.exe)
• FlexNet utility program (lmutil.exe)
• FlexNet Control Panel (lmtools.exe)

The license server manager (lmgrd.exe) and the vendor daemon (LMCOMSOL.exe) 
run on the license server. When a user starts COMSOL on a client computer, 
communication is established through the network from the client to the license 
server and the license server manager (lmgrd.exe). The license server manager 
then makes a request to the vendor daemon (LMCOMSOL.exe), which releases 
licenses according to information in the license.dat file. The FlexNet utility 
program (lmutil.exe) is used for handling license server management tasks, with 
the FlexNet Control Panel (lmtools.exe) as its optional graphical user interface.
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FlexNet® License Manager Documentation

For detailed information on the FlexNet® license manager software, select File > 
Help > Documentation, and scroll to the bottom of the page to locate a PDF copy 
of the FlexNet Publisher License Administration Guide.
You can also find the guide in your installation directory. The default location is

C:\Program Files\COMSOL\COMSOL64\Multiphysics\doc\pdf\COMSOL_Multiphysics\
FlexNet

Note: This PDF file is only available if you have locally installed documentation.

The License Fi le and The License Features

The license file has the same structure on all platforms. In this section, the most 
important parts of the license file are explained. Below is an example of the 
contents of a license.dat file:

#------------------------------------------------------------------
# COMSOL 6.4 FNL License No: 1234567
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
SERVER apollo.thecompany.com 0050569e1b87 1718
USE_SERVER
VENDOR LMCOMSOL port=1719
FEATURE SERIAL LMCOMSOL 6.4 permanent uncounted \
    VENDOR_STRING=C,5701108 HOSTID=ANY BORROW=720 SN=1234567 TS_OK \
    SIGN=0C3A8BF6722E
INCREMENT COMSOL LMCOMSOL 6.4 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT COMSOLGUI LMCOMSOL 6.4 permanent 4 SUPERSEDE DUP_GROUP=UHD \
    ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT HEATTRANSFER LMCOMSOL 6.4 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLIENTSERVER LMCOMSOL 6.4 permanent 4 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT CLUSTERNODE LMCOMSOL 6.4 permanent 4 SUPERSEDE DUP_GROUP=U \
    ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC
INCREMENT COMSOLBATCH LMCOMSOL 6.4 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
INCREMENT HEATTRANSFERBATCH LMCOMSOL 6.4 permanent 2 SUPERSEDE \
    DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
    SIGN=123456789ABC
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THE COMMENT LINES

Comment lines can be included in the license file by starting them with the hash 
symbol #. These lines have no effect on the license server or client.

THE SERVER LINE

In the license.dat file, the line starting with SERVER should contain:
• The hostname of the license server. In the example above, the hostname is 

apollo.thecompany.com. This name can be edited by the user.
• The hostid of the license server. In the example above, the hostid is 

0050569e1b87. This number cannot be edited by the user.
• A port number. In the example above, the port number is 1718. This 

number can be edited by the user.

Confirm that the license server hostname is the actual name of your license server 
(the computer that you intend to run the license manager on); otherwise, change 
it by editing the file. The default port number (1718) can be changed if another 
program is already using it (you will get an error message indicating this when 
starting the license manager). If the default port number 1718 is in use, change it 
to any other number between 1025 and 64,000.

THE USE_SERVER LINE

The USE_SERVER line, with no arguments, does not impact the license manager but 
has implications for the client. When a COMSOL client sees the USE_SERVER line, 
it ignores everything in the license file except the preceding SERVER lines and 
transfers checkout validation to the vendor daemon. This means that if you are 
running COMSOL on one computer, and the license manager on a different 
computer, your license file can only contain two lines: the SERVER line and the 
USE_SERVER line.

THE VENDOR LINE

The VENDOR line defines the name of the LMCOMSOL vendor daemon. This name 
cannot be changed. The vendor daemon is a process that has to be running 
together with the license manager and is automatically started when the license 
manager is started. The LMCOMSOL vendor daemon requires its own port number. 
In the example above, the default port number 1719 is shown.
If the license manager is running on a computer with an active firewall and the 
COMSOL client is outside of that firewall, at least two port numbers must be 
opened up in the license server’s firewall to allow client computers to connect to 
the license manager and the vendor daemon.
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Using the example license file above, configure the firewall to allow access to the 
port numbers 1718 and 1719. If you have chosen other port numbers and 
modified the license.dat file accordingly, configure the firewall to allow access to 
your chosen port numbers. If you are unsure about which port numbers are free 
or how to enable firewall port access, contact your system administrator.
You cannot modify anything in the license.dat file except the license server name 
and (if necessary) port numbers, or the license might not work.

THE SERIAL LINE

The SERIAL line contains information on the license type, license number, and the 
products included in the license.

THE INCREMENT AND FEATURE LINES, AND LICENSE FEATURES

The INCREMENT or FEATURE lines contain a license feature name, version, expiration 
date, and the number of available licenses. The example file above shows that the 
user has a perpetual (permanent) COMSOL 6.4 Floating Network License 
allowing four concurrent users of COMSOL Multiphysics and two concurrent 
users of the Heat Transfer Module. Borrowing is enabled and BORROW=720 sets a 
time limit to 720 hours. “SN=” shows the license’s serial number. The number 
after “SIGN=” at the end of each INCREMENT line contains a license key. Long lines 
can be broken by a continuation character (\).

The License Feature Names
The following table contains the license feature names for all products in the 
COMSOL 6.4 product suite (see also additional information about license 
features below the table):

PRODUCT FEATURE NAME

COMSOL Multiphysics COMSOL, COMSOLUSER, COMSOLGUI, 
MODELMANAGERa, CHATBOTb

COMSOL Multiphysics Floating Network 
Licensec

CLIENTSERVER, CLUSTERNODE, 
MODELMANAGERSERVER

COMSOL Server COMSOLSERVER, COMSOLUSER

COMSOL Compiler COMSOLCOMPILER

AC/DC Module ACDC

Acoustics Module ACOUSTICS

Battery Design Module BATTERYDESIGN

CAD Import Module CADIMPORT, CADIMPORTUSER, 
CADREADER
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CFD Module CFD

Chemical Reaction Engineering Module CHEM

Composite Materials Module COMPOSITEMATERIALS

Corrosion Module CORROSION

Design Module DESIGN, CADIMPORT, 
CADIMPORTUSER, CADREADER

ECAD Import Module ECADIMPORT

Electric Discharge Module ELECTRICDISCHARGE

Electrochemistry Module ELECTROCHEMISTRY

Electrodeposition Module ELECTRODEPOSITION

Fatigue Module FATIGUE

File Import for CATIA V5 CATIA5

Fuel Cell & Electrolyzer Module FUELCELLANDELECTROLYZER

Geomechanics Module GEOMECHANICS

Granular Flow Module GRANULARFLOW

Heat Transfer Module HEATTRANSFER

Liquid & Gas Properties Module LIQUIDANDGASPROPERTIES

LiveLink™ for AutoCAD® LLAUTOCAD, CADIMPORT, 
CADIMPORTUSER, CADREADER

LiveLink™ for PTC® Creo® Parametric™ LLCREOPARAMETRIC, CADIMPORT, 
CADIMPORTUSER, CADREADER

LiveLink™ for Excel® LLEXCEL

LiveLink™ for Inventor® LLINVENTOR, CADIMPORT, 
CADIMPORTUSER, CADREADER

LiveLink™ for MATLAB® LLMATLAB

LiveLink™ for Revit® LLREVIT, CADIMPORT, 
CADIMPORTUSER, CADREADER

LiveLink™ for Simulink® LLSIMULINK

LiveLink™ for Solid Edge® LLSOLIDEDGE, CADIMPORT, 
CADIMPORTUSER, CADREADER

LiveLink™ for SOLIDWORKS® LLSOLIDWORKS, CADIMPORT, 
CADIMPORTUSER, CADREADER

Material Library MATLIB

MEMS Module MEMS

Metal Processing Module METALPROCESSING

PRODUCT FEATURE NAME
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COMSOL MULTIPHYSICS LICENSE FEATURES

Each COMSOL Desktop process checks out a COMSOL feature, a COMSOLUSER 
feature, and a COMSOLGUI feature. The COMSOLGUI feature is checked out by a 
COMSOL Desktop process. The COMSOL feature is checked out by all COMSOL 
Multiphysics processes, whether it has a GUI or not. The COMSOLUSER feature is 
checked out to count the number of distinct COMSOL Multiphysics users.
When you use functionality that requires an add-on product, license features 
corresponding to that product will be checked out.
If you run an attached batch job from COMSOL Desktop, the COMSOL feature and 
add-on product features are passed along from COMSOL Desktop to the batch 
job. When the batch job is finished, or when you detach from the batch job, 
COMSOL Desktop takes back the licenses.

Microfluidics Module MICROFLUIDICS

Mixer Module MIXER

Molecular Flow Module MOLECULARFLOW

Multibody Dynamics Module MULTIBODYDYNAMICS

Nonlinear Structural Materials Module NONLINEARSTRUCTMATERIALS

Optimization Module OPTIM

Particle Tracing Module PARTICLETRACING

Pipe Flow Module PIPEFLOW

Plasma Module PLASMA

Polymer Flow Module POLYMERFLOW

Porous Media Flow Module POROUSMEDIAFLOW

Ray Optics Module RAYOPTICS

RF Module RF

Rotordynamics Module ROTORDYNAMICS

Semiconductor Module SEMICONDUCTOR

Structural Mechanics Module STRUCTURALMECHANICS

Subsurface Flow Module SUBSURFACEFLOW

Uncertainty Quantification Module UQ

Wave Optics Module WAVEOPTICS

a. Not included in Class Kit licenses.
b. Adds chatbot components for communication with an AI system.
c. Additional license features for COMSOL Multiphysics when installed using a floating network license

(FNL).

PRODUCT FEATURE NAME
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When you run distributed jobs on a cluster, the CLUSTERNODE feature is checked out 
from each node.

COMSOL MULTIPHYSICS BATCH LICENSE FEATURES

For floating network licenses, a separate set of batch features are available for 
COMSOL Multiphysics and the licensed add-on products. This means that you in 
some cases can continue to use COMSOL Multiphysics locally while running 
batch jobs on remote computers and clusters.
With COMSOL Desktop, you can use batch features by selecting the Use batch 
license checkbox in the Cluster Sweep and Cluster Computing nodes. From the 
command line, you can use the option -usebatchlic to use batch license features.
Batch jobs will check out a batch feature, and when you use functionality that 
requires an add-on product, batch features corresponding to that product will be 
checked out as well.
The name of the batch feature for COMSOL Multiphysics is COMSOLBATCH, and for 
an add-on product it is, for example, RFBATCH for the RF Module. In general, 
BATCH is appended to the feature name corresponding to the add-on product.
A concurrent user can run an unlimited number of distinct batch processes using 
a single license as long as the models in those jobs only differ by parameter values, 
as defined in the Model Builder under Global Definitions > Parameters. This is 
implemented by computing a hash value based on model object features using the 
hash value as vendor value for the DUP_GROUP=UV keyword.
The CLUSTERNODE feature is checked out when batch features are used. When you 
run distributed jobs on a cluster, the CLUSTERNODE feature is also checked out from 
each node.

COMSOL MULTIPHYSICS SERVER LICENSE FEATURES

A COMSOL Multiphysics server process will not check out any license features 
until you connect to it. When you connect using only the COMSOL API it will 
check out a COMSOL feature and a COMSOLUSER feature, as well as features 
corresponding to the add-on products that you use. If you connect to the 
COMSOL Multiphysics server from COMSOL Desktop, all license features that 
have been checked out from the desktop will be passed from COMSOL Desktop 
to the COMSOL Multiphysics server, including the COMSOLGUI feature. When you 
disconnect from the COMSOL Multiphysics server, the license features will be 
passed back from the server to COMSOL Desktop.
In addition to the above, when you connect to a COMSOL Multiphysics server 
from a remote computer, the COMSOL Multiphysics server checks out a 
CLIENTSERVER feature. The CLIENTSERVER feature is available for floating network 
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licenses. When you run distributed jobs on a cluster, the CLUSTERNODE feature is 
checked out from each node.

CAD-SPECIFIC LICENSE FEATURES

For add-on products that use the CAD kernel, the CADIMPORT feature is always 
checked out, in addition to the feature corresponding to the add-on product. For 
example, when you use the Design Module, the CADIMPORT feature is checked out 
in addition to the DESIGN feature.
The CADIMPORTUSER feature is checked out to count the number of distinct 
CADIMPORT users, including Desktop users and batch users for floating network 
licenses.
Under certain circumstances a single CADREADER feature may also be checked out 
when using CAD functionality.

CLASS KIT LICENSE FEATURES

If you have a Class Kit license for academic use, and enable it by using the -ckl 
option, CKL features will be checked out.
The name of the Class Kit license feature for COMSOL Multiphysics is COMSOLCKL, 
and for add-on products it is, for example, RFCKL for the RF Module. In general, 
CKL is appended to the feature name for the corresponding add-on product.

COMSOL SERVER LICENSE FEATURES

Each COMSOL Server process checks out a COMSOLSERVER feature and there is no 
limitation on the number of such checkouts. When you start running applications 
with COMSOL Server, the server checks out CSL and CSLU features corresponding 
to the add-on products. The CSL features are used to allow each user to run four 
applications, and the CSLU features are used to count the number of users.
The COMSOLUSERCSL feature will also be checked out to keep track of distinct 
COMSOL Server users.
The name of the COMSOL Server feature for COMSOL Multiphysics is 
COMSOLCSL, and for add-on products it is, for example, RFCSL for the RF Module. 
In general, CSL is appended to the feature name for the corresponding add-on 
product.
The name of the COMSOL Server user feature for COMSOL Multiphysics is 
COMSOLCSLU, and for add-on products it is, for example, RFCSLU for the RF Module. 
In general, CSLU is appended to the feature name for the corresponding add-on 
product.
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COMSOL SERVER BATCH JOB LICENSE FEATURES

You can launch batch jobs from applications run with COMSOL Server. Batch 
jobs can only be started from running applications and not from the command 
line. The application always uses COMSOL Server batch license features. The 
batch jobs will check out a COMSOLUSERCSL feature as well.
The name of the batch feature for COMSOL Server is COMSOLBACSL, and for 
add-on products it is, for example, RFBACSL for the RF Module. In general, BACSL 
is appended to the feature name for the corresponding add-on product.
A concurrent user can run an unlimited number of distinct batch processes using 
a single license as long as the models in those jobs only differ by parameter values, 
as defined in the Model Builder under Global Definitions > Parameters. This is 
implemented by computing a hash value based on model object features using the 
hash value as vendor value for the DUP_GROUP=UV keyword.
The COMSOLUSERCSL feature will also be checked out to keep track of distinct 
COMSOL Server batch job users.
The CLUSTERNODECSL feature is checked out when the BACSL license features are 
used. When you run distributed jobs on a cluster, the CLUSTERNODECSL feature is 
also checked out from each node.

COMSOL COMPILER LICENSE FEATURES

A COMSOL Compiler license enables you to compile stand-alone applications 
based on models created with COMSOL Multiphysics and most add-on products. 
When you use COMSOL Compiler, compiler license features for COMSOL 
Multiphysics and all allowed add-on products are checked out.
The name of the compiler feature for COMSOL Multiphysics is COMSOLCOMPILER, 
and for add-on products it is, for example, RFCOMPL for the RF Module. In general, 
COMPL is appended to the feature name for the corresponding add-on product.

IDLE TIMEOUT OF LICENSES

For information about the TIMEOUT and TIMEOUTALL settings, see the FlexNet 
Publisher License Administration Guide. See also the following section.

CONFIGURING FLEXNET LICENSE FEATURES

It is possible for the license administrator to configure how the license manager 
handles license features. To do so, create an options file (usually called 
LMCOMSOL.opt) in the format described in the FlexNet Publisher License 
Administration Guide. Additionally, COMSOL has made the following decisions 
that cannot be overridden by the license administrator:
• VENDOR_STRING is used for determining license pools.
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• Borrowed licenses can be returned early.
• Fully qualified domain name matching is not used.
• Minimum LINGER time is 0.
• TIMEOUT is supported. The minimum idle time is 900 seconds (15 minutes). 

If TIMEOUT or TIMEOUTALL is not specified, idle licenses are never timed out.
• Each new license request scans all the license servers.
• The FLEXLM_DIAGNOSTICS environment variable is supported.
• The LM_LICENSE_FILE and LMCOMSOL_LICENSE_FILE environment variables are 

supported, except when running the installer, since the installer needs full 
control of which license file is being used. Note that COMSOL internally 
sets LMCOMSOL_LICENSE_FILE to COMSOL64/Multiphysics/license/license.dat 
if LMCOMSOL_LICENSE_FILE has not already been set by the user.

• License files are not case sensitive.

Instal l ing the License Manager

The license manager components are automatically installed when installing 
COMSOL Multiphysics unless otherwise specified on the Products page of the 
COMSOL Installer; see Products Page. In some cases, the license manager is also 
automatically configured to run as a service. The checkbox for the license manager 
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components can be found last in the list of software components, as seen in the 
picture below:

If you do not intend to run the license manager on the computer for which you 
are installing COMSOL software products, you can clear this checkbox during 
installation.
If you want to install COMSOL on the same computer as the license manager, first 
perform a complete COMSOL installation including the license manager software 
components. When finished, skip the remainder of this section and continue with 
Starting the License Manager.
To install only the license manager, follow the installation instructions for 
COMSOL earlier in this document and, on the Products page, clear all 
checkboxes except the one for the license manager.
If you want to install the license manager on a computer where running the 
COMSOL Installer is inconvenient, please contact COMSOL Support for access 
to the files needed for installing only the license manager.

AUTOMATED LICENSE MANAGER INSTALLATION

The license manager can also be installed via the automated installation process; 
see Automated Installation. Set licmanager = 1 in the answer file to install the 
license manager. To automatically configure the license manager to run as a service 
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on Windows, use licmanager.service = 1 in the setupconfig.ini file and 
provide values for the other licmanager.service.* lines.

Starting the License Manager

The license manager can be started manually, or it can be configured to start 
automatically as a service each time the computer is rebooted.

STARTING THE MANAGER AUTOMATICALLY AS A SERVICE

To set up the license manager as a service from the FlexNet Control Panel 
(LMTOOLS):
1 Locate the COMSOL64\Multiphysics\license\win64 folder and run 

lmtools.exe. Alternatively, run LMTOOLS from the Windows Start menu, 
available under COMSOL Multiphysics 6.4 > COMSOL Launchers > LMTOOLS.

2 On the Service/License File page choose Configuration using Services.
3 Click the Configure Services tab.

4 Make an entry in the Service Name field, for example, COMSOL License Manager.
5 Specify the full paths to lmgrd.exe and license.dat by browsing to their 

locations on your hard drive. The default location for lmgrd.exe is C:\Program 
Files\COMSOL\COMSOL64\Multiphysics\license\win64\lmgrd.exe, and for the 

The installer can set up the license manager to start automatically; 
if it did, you can skip the following section.
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license file, it is 
C:\Program Files\COMSOL\COMSOL64\Multiphysics\license\license.dat. For 
the debug log file, you can use any name of your choice, for example, 
comsol64.log. The default file path to the location of the license manager debug 
log file is C:\ProgramData\COMSOL\comsol64.log.

6 Select the Use Services checkbox (might not be possible on all platforms, but is 
recommended when available) and then the Start Server at Power Up checkbox.

7 Click Save Service. The license manager now starts at automatically when you 
reboot the license server computer. If you want to start the license manager 
right away without restarting the license server computer, click Start Server on 
the Start/Stop/Reread page of the FlexNet Control Panel.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually, browse to the license\win64 folder. Now, 
in a Windows command window enter

lmgrd -c ..\license.dat -l ..\comsol64.log

The license manager is now ready to distribute licenses over the network. It writes 
debug information to the log file COMSOL64\Multiphysics\license\comsol64.log.

Verifying That the License Manager Is Running

Once you start the license manager, it is good practice to verify that the license 
manager service is running. Start the Windows Task Manager and go to the 
Services page. Check that the LMCOMSOL service is running.

Starting COMSOL Multiphysics

After the installation is complete and the license server manager and vendor 
daemon are running on the license server, you can start using the COMSOL 

Make sure your Windows user account has read/write permissions 
for the folder of the debug log file, or the file will not be created.
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products. For more information on how to run COMSOL Multiphysics, see 
Running COMSOL Multiphysics on Windows.

Changing the License

If you have received a new license file — for example, when adding COMSOL 
products to an existing license — replace the current license file with the new one. 
Double-check the contents of this file to make sure it lists the products that the 
license includes. See also The License Feature Names.

RESTARTING THE LICENSE MANAGER

To restart the license manager, follow these steps:
1 In the Windows Start menu, choose COMSOL Multiphysics 6.4 > 

COMSOL Launchers > LMTOOLS.
2 In the FlexNet Control Panel, click, in this order, Stop Server and Start Server.

OBTAINING A HOSTID

If you need to verify the hostid of the license server, you can follow the steps for 
Obtaining the Hostid. Alternatively, if COMSOL is already installed on the license 
server, you can determine the hostid by running the lmhostid command

COMSOL64/Multiphysics/license/win64/lmutil lmhostid

The hostid is typically the Ethernet address (also called a MAC address) of the 
network card. An Ethernet address has six bytes, each with two hexadecimal digits, 
giving a hostid with twelve hexadecimal digits. Alternatively, the hostid can be the 
volume serial number of your C hard drive. The volume serial number has 4 bytes, 
each with two hexadecimal digits, giving a hostid with eight hexadecimal digits.

When the license file has changed, you must restart the license 
manager or reread the license file; otherwise, it continues to use 
the old license file still in memory.
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Using COMSOL on an IPv6 Network

COMSOL has been tested on both IPv6-only networks and hybrid IPv4/IPv6 
networks. To make sure that the license manager uses IPv6, set the environment 
variable FNP_IP_PRIORITY to 6. See the FlexNet Publisher License Administration 
Guide for details.

Troubleshooting License Errors

If you have questions or problems with your installation, see Troubleshooting 
License Errors.
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Running COMSOL Multiphysics on Windows

After the installation is finished, a COMSOL Multiphysics 6.4 folder is created on 
the Windows Start menu. Additionally, a COMSOL Multiphysics 6.4 shortcut 
icon is placed on the Windows desktop:

To start COMSOL Multiphysics, double-click the desktop icon or select 
COMSOL Multiphysics 6.4 from the Windows Start menu.

CROSS-PLATFORM USER INTERFACE

The default user interface for COMSOL is a Windows application. There is also a 
cross-platform user interface that you can start by going to the bin\win64 folder 
in the COMSOL installation directory and double-clicking comsolxpl.exe. The 
cross-platform user interface is identical to the interface on Linux and macOS.

The COMSOL Multiphysics Folder on The Start Menu

Depending on which COMSOL products and software components you have 
licensed and installed, the COMSOL Multiphysics 6.4 folder on the Windows 
Start menu contains a selection of the items in the following list:
• COMSOL Multiphysics 6.4: Starts the COMSOL Desktop.
• COMSOL Documentation: Starts the COMSOL Documentation window, 

from which you can access and search all the installed documentation. By 
default, the PDF documents open inside the COMSOL Documentation 
application; to instead open them in Adobe Acrobat, you need to modify 
browser settings for the Adobe PDF Reader add-on.
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• COMSOL Launchers: Opens a folder with launchers for the following 
additional COMSOL programs and utilities:
- Setup: Starts the COMSOL Setup program, which you can use to add, 

remove, and repair COMSOL products and to change the license.
- Uninstall: Starts the COMSOL Uninstaller. For more information, see 

Removing (Uninstalling) the COMSOL Installation.
- Update: Starts the COMSOL Installer in update mode.
- COMSOL Multiphysics Client 6.4: Starts a COMSOL Multiphysics client 

that can be connected to a COMSOL Multiphysics server.
- COMSOL Multiphysics Server 6.4: Starts a COMSOL Multiphysics server 

that a COMSOL Multiphysics client can connect to.
For more information on running COMSOL in client–server mode, see 
Running COMSOL Multiphysics in Client–Server Mode.

- LMTOOLS: Starts the FlexNet license manager control panel (LMTOOLS). 
For more information, see License Manager Installation on Windows.

- For launching COMSOL Multiphysics with any of the available graphics 
rendering options — OpenGL® and software rendering — the following 
shortcuts are available: COMSOL Multiphysics 6.4 (OpenGL), and 
COMSOL Multiphysics 6.4 (Software).

- This folder also contains launchers for COMSOL Multiphysics, COMSOL 
Documentation, COMSOL with MATLAB (if available), and COMSOL 
with Simulink (if available) which appear on the main COMSOL 
Multiphysics 6.4 Start menu.

Starting COMSOL Multiphysics for a Classkit License

If you have a Classkit License, start COMSOL Multiphysics by double-clicking the 
dedicated Windows desktop icon:
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Creating Desktop Shortcuts Manually

Sometimes it is necessary to create the COMSOL shortcuts manually, for example, 
when COMSOL Multiphysics is installed on a shared network drive.
1 Locate the COMSOL executable. Its default location is

C:\Program Files\COMSOL\COMSOL64\Multiphysics\bin\win64\comsol.exe

2 Right-click comsol.exe and select Create shortcut, which creates a shortcut with 
a default name comsol.exe - Shortcut. If this shortcut is not created on the 
Desktop, then move it there by drag-and-drop.

CREATING A DESKTOP SHORTCUT MANUALLY FOR THE CROSS-PLATFORM 

USER INTERFACE

The cross-platform user interface for COMSOL that is available on macOS and 
Linux has a slightly different look-and-feel than the user interface for Windows. 
You can get access to the cross-platform user interface from

C:\Program Files\COMSOL\COMSOL64\Multiphysics\bin\win64\comsolxpl.exe

assuming that the default installation location has not changed by you during 
installation.
To create a shortcut to the cross-platform user interface, right-click comsolxpl.exe 
and select Create shortcut, which creates a shortcut with a default name 
comsolxpl.exe - Shortcut. If this shortcut is not created on the Desktop, then move 
it there by drag-and-drop.

CREATING DESKTOP SHORTCUTS MANUALLY FOR A CLASSKIT LICENSE

If you manually create a desktop shortcut for a Classkit License, then, in addition 
to the steps above, the shortcut’s Target needs to be modified with additional 
options. Right-click the COMSOL shortcut icon and select Properties. Change the 
text string in the Target field to

"C:\Program Files\COMSOL\COMSOL64\Multiphysics\bin\win64\comsol.exe" 
-Dcs.ckl
"C:\Program Files\COMSOL\COMSOL64\Multiphysics\bin\win64\
comsolclasskit.ini"

(The complete text string must be written on a single row with spaces between the 
command and each argument.)
Here, C:\Program Files\COMSOL\COMSOL64\Multiphysics represents the default 
COMSOL installation directory. This can be changed in the Target field text 
string if your installation is placed in a different folder.
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CREATING DESKTOP SHORTCUTS MANUALLY FOR COMSOL WITH 

MATLAB
If you manually create a desktop shortcut for a COMSOL with MATLAB, then, 
in addition to the steps above, the shortcut’s Target needs to be modified with 
additional options. Right-click the COMSOL shortcut icon and select Properties. 
Change the text string in the Target field to

"C:\Program 
Files\COMSOL\COMSOL64\Multiphysics\bin\win64\comsolmphserver.exe" matlab

(The complete text string must be written on a single row with spaces between the 
command and each argument.)
Here, C:\Program Files\COMSOL\COMSOL64\Multiphysics represents the default 
COMSOL installation directory and this can be changed in the Target field text 
string if your installation is placed in a different folder.

CREATING DESKTOP SHORTCUTS MANUALLY FOR COMSOL WITH SIMULINK

If you manually create a desktop shortcut for a COMSOL with Simulink, then, in 
addition to the steps above, the shortcut’s Target needs to be modified with 
additional options. Right-click the COMSOL shortcut icon and select Properties. 
Change the text string in the Target field to

"C:\Program 
Files\COMSOL\COMSOL64\Multiphysics\bin\win64\comsolmphserver.exe" simulink

(The complete text string must be written on a single row with spaces between the 
command and each argument.)
Here, C:\Program Files\COMSOL\COMSOL64\Multiphysics represents the default 
COMSOL installation directory and this can be changed in the Target field text 
string if your installation is placed in a different folder.

Running COMSOL Multiphysics in Client–Server Mode

When you start COMSOL Multiphysics by, for example, double-clicking the 
Windows desktop icon, COMSOL Multiphysics is run as a single application that 
includes both the COMSOL Multiphysics client and COMSOL Multiphysics 
server, as explained later in this section. However, the COMSOL client–server 
architecture lets you access the COMSOL Multiphysics server — the COMSOL 
computational engine — as a separate process. For example, the COMSOL 
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Desktop can act as a COMSOL Multiphysics client when connected to a 
COMSOL Multiphysics server.

You need a Floating Network License to run the COMSOL Multiphysics server 
and the COMSOL Multiphysics client on separate computers. However, any 
COMSOL license is sufficient for running client and server on the same computer.
The client and server need not run on the same platform. For example, you can 
run the COMSOL Desktop on Windows connecting to a COMSOL Multiphysics 
server on a Linux or macOS computer. This enables offloading heavy-duty 
computations from your personal laptop or desktop to run just the COMSOL 
Desktop graphical user interface. A typical use would be to run the COMSOL 
Multiphysics server on a computer with large amounts of memory (RAM) and 
processing power and to use your personal computer for pre- and postprocessing 
with the COMSOL Desktop.

STARTING A COMSOL MULTIPHYSICS SERVER

The COMSOL Multiphysics server is a single user server allowing multiple 
sessions by the same user, one session at a time. To start a COMSOL Multiphysics 
server, click COMSOL Multiphysics Server in the COMSOL Launchers folder underneath 
your COMSOL Multiphysics folder on the Windows Start menu. When you start 
a COMSOL Multiphysics server from the Windows Start menu, a command 
window appears asking you for a username and password. You can use any 
username and password of your choice, it is only used for connecting a COMSOL 
Multiphysics client with a COMSOL Multiphysics server.

When the COMSOL Multiphysics server starts, it listens for a COMSOL 
Multiphysics client connection on the port listed in the command window. In the 
example above it is port 2036.

The license server is not the same as a COMSOL Multiphysics 
server. The license manager can run on a computer different from 
both the ones used by COMSOL Desktop and COMSOL 
Multiphysics server.
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CONNECTING A COMSOL CLIENT TO A COMSOL MULTIPHYSICS SERVER

You can start a COMSOL Multiphysics client session by clicking COMSOL 
Multiphysics Client in the COMSOL Launcher folder underneath your COMSOL 
Multiphysics folder on the Windows Start menu. You can also connect to a 
COMSOL Multiphysics server from the COMSOL Desktop by selecting File > 
Connect to Server. When you start the Client, a Connect to Server window appears 
prompting you for a computer name (Server) where the COMSOL Multiphysics 
server is running, Port number, Username, and Password.

Once you have filled out this information and clicked OK, the COMSOL 
Multiphysics server command window indicates that a COMSOL Multiphysics 
client has connected. For more information on running COMSOL in client–server 
mode, see the COMSOL Multiphysics Reference Manual.

Running COMSOL Multiphysics in Batch Mode

You can submit COMSOL Multiphysics batch jobs from the COMSOL Desktop 
and the command line.
To run a COMSOL Multiphysics batch job from the COMSOL Desktop, you 
need to make the Batch feature visible: in the Model Builder tree, click the Show 
More Options button ( ) and select Batch and Cluster in the Show More Options 
dialog. In the Model Builder, right-click a Study node and select Batch to create 
batch jobs.
From the Windows command window, you can start batch jobs by using the 
comsolbatch command. For example:

comsolbatch -inputfile in.mph -outputfile out.mph

To run a specific study add the command line option -study <tag>, where <tag> 
is the tag of the study to run, for instance, std1. To see the tag, click the toolbar 
button Model Tree Node Text in the Model Builder and select Tag.
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The COMSOL Multiphysics Reference Manual has a dedicated section on 
running COMSOL Multiphysics from the Windows command window, including 
a list of COMSOL commands and associated syntax.

Multicore Settings

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support. This section covers shared-memory processing, or 
multithreading, which is important for the performance of COMSOL 
Multiphysics computations. Some terms that are frequently used when describing 
multithreading are:
• Core: The core is a processor core used in shared-memory parallelism by a 

computational node with multiple processors.
• Speedup is how many times faster a job runs on N cores compared to 1 core, 

on a specific compute node. The speedup depends on the simulation type, 
the hardware used, and hardware drivers used.

In Windows, the default number of processor cores used by COMSOL 
Multiphysics is the total number of available physical cores. For example, if you 
have a 2 x dual core machine, 4 cores are used in parallel by a COMSOL 
Multiphysics process.
To find out how many processor cores your Windows machine has:
1 Start the Windows Task Manager (press Ctrl+Shift+Esc, or right-click the 

taskbar and select Task Manager in the context menu).
2 On the Performance page, click CPU. The number of cores can be seen as the 

number next to Cores.

If you want COMSOL Multiphysics to leave out one or more processor cores, you 
can set the number of cores used for a computational job in the Preferences 
window on the Computing > Multicore page (by first selecting the Number of cores 
checkbox and then entering the number of processor cores to use).
You can also change the default behavior of COMSOL Multiphysics by setting the 
environment variable COMSOL_NUM_THREADS to the desired number of cores. See the 
COMSOL Multiphysics Reference Manual for more information.
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Running COMSOL Multiphysics on Clusters

You can launch COMSOL cluster jobs from the COMSOL Desktop and the 
command line. To run COMSOL Multiphysics on a cluster, you need to make the 
cluster features visible: in the Model Builder tree, click the Show More Options 
button ( ) and select Batch and Cluster in the Show More Options dialog. Then, 
in the Model Builder, right-click a Study node and select Cluster Computing or 
Cluster Sweep to create cluster jobs. Cluster computing requires a Floating 
Network License.
The following terms occur frequently when describing the hardware for cluster 
computing and shared-memory parallel computing:
• Compute node: The compute nodes are where the distributed computing 

occurs. Each distributed COMSOL process resides in a compute node and 
communicates with other compute nodes using MPI (message-passing 
interface).

• Host: The host is a physical machine (hardware) with a network adapter and 
unique network address. The host is part of the cluster. It is sometimes 
referred to as a physical node.

• Core: The core is a processor core used in shared-memory parallelism by a 
computational node with multiple processors.

The number of hosts and the number of compute nodes are usually the same. For 
some special problem types, like very small problems with many parameters, it 
might be beneficial to use more than one computational node on one host.
A tutorial for cluster testing is included in the Application Libraries window under 
COMSOL Multiphysics/Cluster_and_Batch_Tutorials/micromixer_cluster.

RUNNING FROM A DESKTOP PC
To access the COMSOL Multiphysics running on a cluster, it is recommended to 
work on a desktop PC. To do so, use one of the following options:
• Install COMSOL Multiphysics on your local PC. Also install the client 

portion of Microsoft HPC Pack on the desktop PC. Use a version that is 
compatible with the version of Windows Server that is installed on the 
cluster. Microsoft HPC Pack enables you to access the cluster from your 
workstation.

• Alternatively, connect to the head node via a remote desktop connection and 
start COMSOL Multiphysics on the head node.
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QUICK TROUBLESHOOTING

• Your first step is to make sure you have the latest release installed. Check that 
you have COMSOL Multiphysics 6.4 or later. Also make sure to install the 
latest product updates.

• For Windows HPC Server, log in to each node with remote desktop and 
start the COMSOL Desktop GUI. No error messages should be displayed.

• If you get the error message “Process status indicates that process is 
running,” then cancel any running jobs in the Windows HPCS Job manager 
or other scheduler that you use. In the COMSOL Desktop, locate the 
External Process page at the lower-right. Click the Clear Status button.

For more information about how to run COMSOL Multiphysics in parallel on 
Windows clusters, see the COMSOL Multiphysics Reference Manual. For 
installation on Clusters, see Cluster Installation.

Running COMSOL Multiphysics on the Cloud

COMSOL Multiphysics and COMSOL Server support cloud computing. See
• www.comsol.com/partners-consultants/hpc
• www.comsol.com/model/

running-the-comsol-software-with-amazon-ec2-14075
• www.comsol.com/model/

running-the-comsol-software-with-microsoft-azure-89751

Running COMSOL Multiphysics with MATLAB

Running COMSOL Multiphysics with MATLAB requires a LiveLink™ 
for MATLAB® license. To run COMSOL Multiphysics with MATLAB, 
double-click the COMSOL Multiphysics 6.4 with MATLAB icon on the desktop.
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Alternatively, start COMSOL Multiphysics with MATLAB from the Start menu 
by pointing to Programs, then to COMSOL Multiphysics 6.4, and then select 
COMSOL Multiphysics 6.4 with MATLAB.
Running COMSOL Multiphysics with MATLAB starts a COMSOL Multiphysics 
server and a MATLAB Desktop. The COMSOL Desktop is not started. You can 
change the path to the MATLAB installation in the Preferences window accessed 
from the Options menu of the COMSOL Desktop. For more information, see the 
LiveLink™ for MATLAB® documentation.

STARTING COMSOL MULTIPHYSICS WITH MATLAB USING THE GRAPHICS 

SERVER

To display the plot in a COMSOL graphics window you need to run COMSOL 
Multiphysics with MATLAB using the graphics server. To do so, append the flag 
-graphics to the COMSOL Multiphysics with MATLAB target path.

Running COMSOL Multiphysics with Simulink

Running COMSOL Multiphysics with Simulink requires a LiveLink™ 
for Simulink® license. To run COMSOL Multiphysics with Simulink, double-click 
the COMSOL Multiphysics 6.4 with Simulink icon on the desktop.

Alternatively, start COMSOL Multiphysics with Simulink from the Start menu by 
pointing to Programs, then to COMSOL Multiphysics 6.4, and then select 
COMSOL Multiphysics 6.4 with Simulink.
Running COMSOL Multiphysics with Simulink starts a COMSOL Multiphysics 
server and a MATLAB Desktop. The COMSOL Desktop is not started.
You can change the path to the MATLAB installation in the Preferences window 
accessed from the Options menu of the COMSOL Desktop. For more 
information, see the LiveLink™ for Simulink® documentation.
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Installing on macOS

Instal lation Over the Internet

INSTALLATION OF A TRIAL LICENSE OVER THE INTERNET

A trial license can be given to you with the intention to test the software without 
any payment obligation for noncommercial and nonproduction use. This option 
is not available in all regions.
Installation of a Single User Trial License requires a license passcode. A passcode 
has a form similar to:

FFFFFFFF-TYUS-123456-1234567-123456789

This is usually sent to you by your COMSOL representative by email. Once you 
locate your passcode, follow these steps to prepare for download and installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.

2 If you have not already created a COMSOL Access account, you are prompted 
to create it. When you have created the account, you can enter your license 
passcode to associate it with your account information.
If you already created a COMSOL Access account, you can associate the license 
file with your account on the COMSOL Access page under Manage Licenses at 
www.comsol.com/access/licenses.

3 Follow the web-based instructions to download the software.
4 Continue with the instructions in the section Downloading and Installing the 

COMSOL Software.

A license passcode can also be used for class kit licenses (CKL).

INSTALLATION OF A PAID-FOR LICENSE OVER THE INTERNET

Installation of any paid-for license on macOS requires a license file that is sent to 
you by your COMSOL representative by email. To be able to generate the license 
file, information about your hardware is needed in the form of a hostid (host ID). 
The hostid is used to lock the license to your hardware and needs to be sent by 
you to a COMSOL representative prior to the license file being generated.
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Obtaining the Hostid
Follow these steps to obtain a hostid:
1 From the Apple menu, open System Settings and select Network.
2 Select the correct network adapter and then click Details....
3 Select the Hardware tab where you will find the MAC address listed.
4 If there are multiple network adapters, report the MAC address for all of them. 

These numbers should each consist of 12 characters.

Obtaining the Hostname
If you have been informed by your COMSOL representative that you need to run 
a license manager for your installation, then you also need the hostname. To get 
the hostname, launch the Terminal application and run the hostname command.
If your network administrator has set a fixed IP address for your computer, this IP 
Address can be used in place of the hostname. For more information on license 
manager installation, see License Manager Installation on macOS.
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Obtaining the License File from a COMSOL Representative
Send the hostid information, as well as hostname, if applicable, in an email to your 
COMSOL representative, who will respond with an email including an attached 
license file (license.dat). Save this file to your local Home folder to ensure that 
the COMSOL installer will be able to read it during the installation process. Avoid 
protected folders such as Desktop, Documents, and Downloads.
Below is an example of the contents of a license.dat file for a Single User License 
on macOS. The license file is a text file, and this example shows that the licensed 
products are COMSOL Multiphysics, Particle Tracing Module, Subsurface Flow 
Module, and LiveLink™ for Excel®.

#------------------------------------------------------------------
# COMSOL 6.4 NSL License No: 1234567 Windows/Mac
# Visit www.comsol.com/install for latest installation instructions
#------------------------------------------------------------------
FEATURE SERIAL LMCOMSOL 6.4 permanent uncounted \

VENDOR_STRING=C,18000100200 HOSTID=ANY sort=100 SN=1234567 \
TS_OK SIGN=8045890A6FE4

FEATURE COMSOL LMCOMSOL 6.4 permanent uncounted HOSTID="70f2b13f4dfd \
0116b8cc761a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=E607EB680852

FEATURE PARTICLETRACING LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3835733C6290

FEATURE SUBSURFACEFLOW LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3A9BA162C9E4

FEATURE LLEXCEL LMCOMSOL 6.4 permanent uncounted HOSTID="70f1a12f4dfc \
0026b9cc760a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=EE9C11E44356

FEATURE COMSOLGUI LMCOMSOL 6.4 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=0D0A83382550

A Single User License file can normally not be edited or changed in any way by 
the user but has to be identical to the one sent to you by a COMSOL 
representative. However, if you were sent a license file that requires a license 
manager, then minor edits are required. For information on the type of license file 
required for installations using a license manager, see The License File.

Registering with COMSOL Access
Once you have saved your license file, follow these steps to register or login to 
COMSOL Access and to start the installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.
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2 If you have not already created a COMSOL Access account, you are prompted 
to create it. While creating the account, point to your license file (license.dat) 
to associate it with your account information.
If you already created a COMSOL Access account, then you can associate the 
license file on the COMSOL Access page with your account under Manage 
Licenses at www.comsol.com/access/licenses.

3 Continue with the instructions in the next section.

Downloading and Instal l ing the COMSOL Software

1 Go to the web page www.comsol.com/product-download. To download the 
COMSOL installer, you must first create a COMSOL Access account as 
described in the section Installation over the Internet.

2 You are now given the option of downloading the COMSOL online installer or 
the COMSOL offline installer. For both options, make sure to download the 
version that matches your computer’s CPU architecture:
- COMSOL64_macarm64.dmg or COMSOL64_maci64.dmg (online).
- COMSOL64_full_macarm64.dmg or COMSOL64_full_maci64.dmg (offline). 

STARTING THE INSTALLER

The COMSOL Installer is a user interface tool that guides you through the 
installation process. To run the installer:
1 Mount the DMG-file by double-clicking it and open it in Finder.
2 Launch the COMSOL Installer by double-clicking COMSOL Setup. 
3 The COMSOL 6.4 Installer window should now appear. Continue with the 

instructions in the section Running The COMSOL Installer below.

If you have problems downloading (such as Error downloading file. 

Connection refused: connect), please review this knowledge base 
entry: www.comsol.com/support/knowledgebase/1149. If you 
still have problems, contact your local COMSOL representative or 
technical support from the Support Center page 
www.comsol.com/support.
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Instal lation from USB Flash Drive

If you have received a USB Flash Drive from a COMSOL representative:
1 Connect the USB Flash Drive to your computer and open it in Finder.
2 Launch the COMSOL Installer by double-clicking COMSOL Setup.
3 The COMSOL 6.4 Installer window should now appear. Continue with the 

instructions in the section Running The COMSOL Installer below.

Running The COMSOL Instal ler

The steps for running the COMSOL Installer are independent of the installation 
media. If you have followed the above instructions, the COMSOL Installer should 
now appear. Continue with the instructions for Windows in the section Running 
the COMSOL Installer.

Automated Instal lation

You can install the COMSOL software using an automated installation process 
with minimal user interaction. This method requires installation from the offline 
installer and an answer file.
The answer file is a text file with a specific format that contains predefined settings 
for the COMSOL installer. If non-ASCII characters are used, the answer file is 
expected to be UTF-8 encoded by default, but UTF-16 is also supported if the 
file starts with a byte order mark (BOM).
A template answer file, setupconfig.ini, with detailed usage information is 
available in the DMG image.
To perform an automated installation:
1 Open the DMG file in Finder.
2 Copy setupconfig.ini to a local directory and customize it as needed.
3 Right-click COMSOL 6.4 Installer and select Show Package Contents.
4 Navigate to Contents > Resources and locate the setup executable.
5 Open a Terminal window.
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6 Click and drag the setup executable to the terminal window. The full path 
should be copied to the command prompt.

7 In the terminal, add -s and the full path of your setupconfig.ini file to the 
command, with spaces in between. If needed, it should be possible to click and 
drag the setupconfig.ini file to the terminal to input the path.

8 Run the command, which should now resemble something like this:
/Volumes/COMSOL64_full_macarm64/COMSOL\ 6.4\ Installer.app/Contents/
Resources/setup -s /Users/username/Desktop/setupconfig.ini

or this:
/Volumes/COMSOL64_full_maci64/COMSOL\ 6.4\ Installer.app/Contents/
Resources/setup -s /Users/username/Desktop/setupconfig.ini

depending on the CPU architecture.

Removing (Uninstal l ing) the COMSOL Instal lation

To remove a COMSOL installation from your system, you can use the COMSOL 
Installer’s uninstallation option. This removes all the files and directories that were 
initially created by the COMSOL Installer. Files and directories that were created 
or modified after the installation are not removed.
You can start the COMSOL Uninstaller in a few different ways:
• Launch the COMSOL Setup application from the installation directory, and 

select Uninstall COMSOL 6.4.
• Launch the COMSOL Installer using the same method as for the original 

installation, and select Uninstall COMSOL 6.4.
• In a terminal window, run the following command:

/Applications/COMSOL64/Multiphysics/setup uninstall

Alternatively, to remove the COMSOL installation, you can also delete the 
COMSOL64 folder including all subfolders. The following file may also be added by 
the installer: /Library/LaunchDaemons/com.comsol.lmcomsol.plist.
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Product Updates and Application Library Update

COMSOL periodically releases product updates with improvements and 
corrections to reported problems. By default, COMSOL does not check for 
updates at startup. You can turn this feature on and off from the Preferences 
window accessible from the COMSOL Desktop. Here you can also configure 
settings for the Application Library Update.
The COMSOL Application Library is updated on a regular basis by COMSOL. 
To open the Application Library Update window from the File > Help menu 
(Windows users) or from the Help menu (macOS and Linux users), select Update 
COMSOL Application Libraries.
This connects you to the COMSOL Application Update website where you can 
access the latest updates. This includes files that have been added or improved 
since the latest product release.
Using the Updates section in the Preferences window, which you open from the 
COMSOL Desktop, you can configure proxy server settings as well as application 
and documentation directories for the Application Library Update. See the 
COMSOL Multiphysics Reference Manual for more information including 
command-line options for the Application Libraries.
As an alternative, you can update COMSOL without starting the update from 
inside COMSOL Multiphysics. To do this, run COMSOL Update.app.

AUTOMATED UPDATES

You can update the COMSOL software using an automated update process with 
minimal user interaction using the abovementioned DAT-file. Consult 
www.comsol.com/product-update for detailed instructions.

Changing the Path to the MATLAB® Instal lation

You can change the path to the MATLAB installation in the Preferences > LiveLink 
Connections window accessed from the Options menu of the COMSOL Desktop. 
For more information, see the LiveLink™ for MATLAB® documentation.
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Cluster Instal lation

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support. This section is dedicated to distributed-memory parallel 
installation.
COMSOL Multiphysics can distribute computations on compute clusters using 
the MPI model. One large simulation can be distributed across many compute 
nodes. Also, parametric sweeps can be done with individual parameter cases 
distributed to each cluster node.

SYSTEM REQUIREMENTS

The installation instructions above can also be followed for clusters. COMSOL 
supports shared-memory parallelism and distributed-memory parallelism on 
macOS with Apple silicon. For details on system requirements, including 
additional software packages required for certain configurations, see 
www.comsol.com/system-requirements.

LICENSE MANAGER

COMSOL Multiphysics requires a Floating Network License for running on 
clusters. Please check the license file for the CLUSTERNODE feature, which needs to 
be present to enable the cluster computing functionality. The license manager 
needs to be accessible from all nodes in the cluster. Therefore it is often a good 
idea to have it run on the head node.

INSTALLATION FOLDER

The COMSOL installation folder should be shared between all compute nodes 
and the head node.

FEATURES

During installation, make sure the Cluster Components feature is selected.

ACCESS TO CLUSTER

If you work on a computer that is not on the cluster, install COMSOL 
Multiphysics on that computer. Typically, you use a scheduler to launch jobs on 
the cluster. Make sure the scheduler client software is installed on that computer. 
You can configure the installation to use the scheduler by changing the 
comsol.ini file according to the section on MPI Options in the COMSOL 
Multiphysics Reference Manual.
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For more information on installing and running COMSOL on clusters, see 
Running COMSOL on Clusters and the COMSOL Multiphysics Reference 
Manual.
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License Manager Installation on macOS

Many of the instructions for installing the license manager are similar to those for 
Windows. This section covers only the differences when installing on macOS. For 
general information on the license manager software, see License Manager 
Installation on Windows.

FlexNet® License Manager Software Components

The license manager consists of the following software components:
• License server manager (lmgrd)
• Vendor daemon (LMCOMSOL)
• FlexNet utility programs (lmutil and others)

The license server manager (lmgrd) and the vendor daemon (LMCOMSOL) run on the 
license server. When a user starts COMSOL Multiphysics on a client computer, 
communication is established through the network from the client to the license 
server and the license server manager (lmgrd). The license server manager then 
makes a request to the vendor daemon (LMCOMSOL), which releases licenses 
according to information in the license.dat file. The FlexNet utility programs are 
used for handling license server management tasks.

FlexNet® License Manager Documentation

For detailed information on the FlexNet® license manager software, select Help > 
Documentation in the COMSOL Desktop and scroll to the bottom of the page to 
locate a PDF copy of the FlexNet Publisher License Administration Guide.
Note: This PDF file is only available if you have locally installed documentation.
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The License Fi le

The license file for use on macOS is identical to that for Windows. See The License 
File and The License Features for more information.

Instal l ing the License Manager

The license manager components are automatically installed when installing the 
COMSOL software unless otherwise specified on the Products page of the 
COMSOL Installer; see Products Page. The checkbox for the license manager 
components can be found last in the list of software components.
If you want to install COMSOL on the same computer as the license manager, 
perform a complete COMSOL installation and make sure to include the license 
manager components.
If you want to install the license manager on a computer where running the 
COMSOL Installer is inconvenient, please contact COMSOL Support for access 
to the files needed for installing only the license manager.

LICENSE MANAGER PAGE

See License Manager Page for information about the license manager settings in 
the installer. For macOS, this page also contains some additional settings: 
• In the User to run license manager field, enter the username for the user that 

will run the license manager. If left empty, the root user will run the license 
manager, which is not recommended from a security point of view.

• Optionally, specify a group the user belongs to in the Group of the user field.

Note: The License Manager page only appears if the installer is started by a 
superuser (such as root or by using sudo). 

To run the installer with sudo:
1 Open the DMG-file in Finder.
2 Right-click COMSOL 6.4 Installer and select Show Package Contents.
3 Navigate to Contents > Resources and locate the setup executable.
4 Open a Terminal window.
5 Click and drag the setup executable to the terminal window. The full path 

should be copied to the command prompt.
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6 In the terminal, add sudo to the start of the command.
7 Run the command, which should resemble something like this:

sudo /Volumes/COMSOL64_macarm64/COMSOL\ 6.4\ Installer.app/Contents/
Resources/setup

or
sudo /Volumes/COMSOL64_maci64/COMSOL\ 6.4\ Installer.app/Contents/
Resources/setup

depending on the CPU architecture.

When finished, skip the remainder of this section and continue with Starting the 
License Manager.
To install only the license manager, follow the installation instructions for 
COMSOL earlier in this document, and, on the Products page, clear all 
checkboxes except the one for the license manager.

AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation 
process with minimal user interaction; for this option, see Automated Installation. 
Set licmanager = 1 in the answer file to install the license manager. It is also 
possible to automatically configure the license manager to run as a service. Use 
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licmanager.service = 1 in the setupconfig.ini file and provide values for the 
other licmanager.service.* lines.

Starting the License Manager

Either start the license manager manually or let it run automatically at startup.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually:
1 Change directory to the license/macarm64 or license/maci64 directory:

cd /Applications/COMSOL64/Multiphysics/license/macarm64

or
cd /Applications/COMSOL64/Multiphysics/license/maci64

depending on your CPU architecture.

2 Start the license manager:
./lmgrd -c ../license.dat -l /var/tmp/comsol64.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol64.log.

STARTING THE LICENSE MANAGER AUTOMATICALLY AT STARTUP

To configure the license manager to run automatically at startup:
1 Copy the template file com.comsol.lmcomsol.plist to /Library/

LaunchDaemons:
sudo cp /Applications/COMSOL64/Multiphysics/license/macarm64/
com.comsol.lmcomsol.plist /Library/LaunchDaemons/

or
sudo cp /Applications/COMSOL64/Multiphysics/license/maci64/
com.comsol.lmcomsol.plist /Library/LaunchDaemons/

depending on your CPU architecture.
Typically, the template file must be edited: the lmgrd and license.dat paths 
should be updated, and a user that is not root should be specified for running 
the service.

2 Open the file /Library/LaunchDaemons/com.comsol.lmcomsol.plist in a text 
editor, for example, TextEdit, and make the necessary edits.
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3 Set the correct permissions for the file:
sudo chmod 600 /Library/LaunchDaemons/com.comsol.lmcomsol.plist

4 Enable and start the daemon:
sudo launchctl load -w /Library/LaunchDaemons/com.comsol.lmcomsol.plist

To disable automatic startup for the license manager and remove the license 
manager daemon:
1 Stop and disable the daemon:

sudo launchctl unload -w /Library/LaunchDaemons/com.comsol.lmcomsol.plist

2 Remove the service file:
sudo rm -rf /Library/LaunchDaemons/com.comsol.lmcomsol.plist

3 Remove the log file:
rm /var/tmp/comsol64.log

Verifying That the License Manager Is Running

Once you start the license manager, it is good practice to verify that the license 
manager processes are running. Open the Activity Monitor and look for the 
vendor daemon (LMCOMSOL) and license server manager (lmgrd) processes.

Starting COMSOL Multiphysics

After the installation is complete and the license manager is running on the license 
server, you can start using COMSOL Multiphysics. For more information on how 
to run COMSOL Multiphysics, see Running COMSOL Multiphysics on macOS.

Changing the License

If you have received a new license file — for example, when adding COMSOL 
products to an existing license — replace the current license file with the new one 
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and then restart the license manager or reread the license file. Double-check the 
contents of the new file to make sure it lists all the products included in the license.

RESTARTING THE LICENSE MANAGER

To restart the license manager:
1 Change the directory to license/macarm64 or license/maci64:

cd /Applications/COMSOL64/Multiphysics/license/macarm64

or
cd /Applications/COMSOL64/Multiphysics/license/maci64

depending on your CPU architecture.

2 Stop the license manager:
./lmdown -c ../license.dat

3 Restart the license manager:
./lmgrd -c ../license.dat -l /var/tmp/comsol64.log

OBTAINING A HOSTID

If you need to verify the hostid of the license server, you can follow the steps in 
Obtaining the Hostid. Alternatively, if COMSOL is already installed on the license 
server, you can determine the hostid by running the lmhostid command:

COMSOL64/Multiphysics/license/macarm64/lmhostid

or
COMSOL64/Multiphysics/license/maci64/lmhostid

depending on your CPU architecture.
The hostid is typically the Ethernet address (also called a MAC address) of the 
network card of your computer. An Ethernet address has six bytes, each with two 
hexadecimal digits. Thus, the full hostid has twelve hexadecimal digits.

When the license file has changed, you must restart the license 
manager or reread the license file; otherwise, it continues to use 
the old license file still in memory.
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Using COMSOL on an IPv6 Network

COMSOL has been tested on both IPv6-only networks and hybrid IPv4/IPv6 
networks. To make sure that the license manager uses IPv6 for communication, 
set the environment variable FNP_IP_PRIORITY to 6. See the FlexNet Publisher 
License Administration Guide for details.

Troubleshooting License Errors

If you have questions or problems with your installation, see Troubleshooting 
License Errors.
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Running COMSOL Multiphysics on macOS

The COMSOL Applications

After the installation is finished there are several COMSOL applications available. 
How many are available depends on which products and licenses you have:

COMSOL Multiphysics This is the primary application for running COMSOL 
Multiphysics. It launches COMSOL Multiphysics as a standalone application.

COMSOL Multiphysics (Classkit License) This application launches COMSOL 
Multiphysics for a Classkit License. This application is only available if you have a 
Classkit License.

COMSOL Documentation This application starts the COMSOL Documentation 
window, from which you can access and search all the installed documentation.

COMSOL with MATLAB Use this application for running COMSOL with 
LiveLink™ for MATLAB®. This application is only available if you have a 
LiveLink™ for MATLAB® license.

COMSOL with Simulink Use this application for running COMSOL with 
LiveLink™ for Simulink®. This application is only available if you have a LiveLink™ 
for Simulink® license.

COMSOL Multiphysics Server This application launches the Terminal application 
and starts a COMSOL Multiphysics server in a terminal window.

COMSOL Update This application checks for available product updates on 
www.comsol.com

COMSOL Setup This application makes it possible to add, remove, and repair 
COMSOL products and to change the license.

The COMSOL applications do not work if moved outside the 
COMSOL folder. Create an alias if, for example, a desktop icon is 
required.
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Running COMSOL Multiphysics from a Terminal Window

COMSOL Multiphysics can also be launched from a terminal window using the 
shell script COMSOL64/Multiphysics/bin/comsol.
To run the comsol command more easily, include the COMSOL64/bin directory in 
the path or make a symbolic link from /usr/bin/comsol to the comsol script. 
Those with administrator privileges can create a symbolic link with the command

sudo ln -s /Applications/COMSOL64/Multiphysics/bin/comsol /usr/bin/comsol

(assuming COMSOL Multiphysics is installed in the default Applications folder). 
This command asks for a password before creating the link.

Running a Classkit License

To start COMSOL Multiphysics with a Classkit License, use the -ckl 
command-line option. For example:

/Applications/COMSOL64/Multiphysics/bin/comsol -ckl

Running COMSOL on Clusters

You can launch COMSOL Multiphysics cluster jobs from the COMSOL Desktop 
and the command line.
To run COMSOL Multiphysics on a cluster from the COMSOL Desktop, you 
need to make the cluster feature visible: in the Model Builder tree, click the Show 
More Options button ( ) and select Batch and Cluster in the Show More Options 
dialog. Then in the Model Builder, right-click a Study node and select Cluster 
Computing or Cluster Sweep to create cluster jobs. Cluster computing requires a 
Floating Network License.

The comsol command must not be moved from the COMSOL64/
Multiphysics/bin folder. The COMSOL applications also use this 
script.
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The following terms occur frequently when describing the hardware for cluster 
computing and shared memory parallel computing:
• Compute node: The compute nodes are where the distributed computing 

occurs. Each distributed COMSOL process resides in a compute node and 
communicates with other compute nodes using MPI (message-passing 
interface).

• Host: The host is a physical machine (hardware) with a network adapter and 
unique network address. The host is part of the cluster. It is sometimes 
referred to as a physical node.

• Core: The core is a processor core used in shared-memory parallelism by a 
computational node with multiple processors.

The number of used hosts and the number of computational nodes are usually the 
same. For some special simulation types, like very small simulations with many 
parameters, it might be beneficial to use more than one computational node on 
one host.
A tutorial model for cluster testing is included in the Application Libraries window 
under COMSOL Multiphysics/Cluster_and_Batch_Tutorials/micromixer_cluster.

QUICK TROUBLESHOOTING

• First, ensure that you have the latest release installed. Check that you have 
COMSOL 6.4 or later and make sure to install the latest product updates.

• If you get the error message Process status indicates that process is running, 
then cancel any running jobs in the scheduler that you use. In the COMSOL 
Desktop, locate the External Process page at the lower-right. Click the Clear 
Status button.

For more information about how to run COMSOL Multiphysics in parallel on 
Mac clusters, see the COMSOL Multiphysics Reference Manual. For installation 
on Clusters, see Cluster Installation.

Running COMSOL Multiphysics in Client–Server Mode

When you start COMSOL Multiphysics by, for example, launching the COMSOL 
Multiphysics application, COMSOL Multiphysics is run as a single application that 
includes the functionality of both the COMSOL Multiphysics Client and 
COMSOL Multiphysics server, as explained later in this section. However, the 
COMSOL client–server architecture lets you access the COMSOL Multiphysics 
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server — the COMSOL computational engine — as a separate process. For 
example, the COMSOL Desktop can act as a COMSOL Multiphysics Client when 
connected to a COMSOL Multiphysics server.

You need a Floating Network License to run the COMSOL Multiphysics server 
and the COMSOL Multiphysics Client on separate computers. However, any 
COMSOL license is sufficient for running the Client and the server on the same 
computer.
The Client and server need not run on the same platform. For example, you can 
run the COMSOL Desktop on macOS and connect to a COMSOL Multiphysics 
server on a Windows or Linux computer. This enables offloading heavy-duty 
computations from your personal laptop or desktop to run just the COMSOL 
Desktop graphical user interface. A typical use would be to run the COMSOL 
Multiphysics server on a computer with large amounts of memory (RAM) and 
processing power and to use your personal computer for pre- and postprocessing 
with the COMSOL Desktop.

STARTING A COMSOL MULTIPHYSICS SERVER

To start the COMSOL Multiphysics server, run the COMSOL Multiphysics 
Server application. A terminal window appears asking you for a username and 
password. You can choose any username and password, it is only used for 
connecting a COMSOL Multiphysics client with a COMSOL Multiphysics server.
When the COMSOL Multiphysics server starts, it listens for a COMSOL 
Multiphysics client connection on the port listed in the command window.

Connecting a COMSOL Multiphysics Client to a COMSOL Multiphysics Server
You can start a COMSOL Multiphysics client session from the COMSOL 
Desktop by selecting Connect to Server from the File menu in the COMSOL 
Desktop. When you start the client, a Connect to COMSOL Multiphysics Server 
window appears prompting you for a computer name (Server) where the 

The license server is not the same as a COMSOL Multiphysics 
server. The license manager can run on a computer different from 
both the ones used by COMSOL Desktop and COMSOL 
Multiphysics server.
 | 97



COMSOL Multiphysics server is running, Port number, Username, and 
Password.

Once you have filled out this information and clicked OK, the COMSOL 
Multiphysics server terminal window displays information that a COMSOL 
Multiphysics client has connected. For more information on running COMSOL 
in client–server mode, see the COMSOL Multiphysics Reference Manual.

Running COMSOL Multiphysics in Batch Mode

You can submit COMSOL Multiphysics batch jobs from the COMSOL Desktop 
and the command line.
To run a COMSOL Multiphysics batch job from the COMSOL Desktop, you 
need to make the Batch feature visible: in the Model Builder tree, click the Show 
More Options button ( ) and select Batch and Cluster in the Show More Options 
dialog. In the Model Builder, right-click a Study node and select Batch to create 
batch jobs.
From the terminal window, you can start batch jobs using the comsol batch 
command. This is an example of how such a command could look:

comsol batch -inputfile in.mph -outputfile out.mph

To run a specific study add the command line option -study <tag>, where <tag> 
is the tag of the study to run, for instance, std1. To see the tag, click the toolbar 
button Model Tree Node Text in the Model Builder and select Tag.
The COMSOL Multiphysics Reference Manual includes a dedicated section on 
running COMSOL Multiphysics from the terminal window, including a list of 
COMSOL commands and associated syntax.
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Multicore Settings

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support for Windows and Linux. This section covers 
shared-memory processing, or multithreading, which is important for the 
performance of COMSOL Multiphysics computations. Some terms that are 
frequently used in when describing multithreading are:
• Core: The core is a processor core used in shared-memory parallelism by a 

computational node with multiple processors.
• Speedup is how many times faster a job runs on N cores compared to 1 core, 

on a specific compute node. The speedup depends on the simulation type, 
the hardware used, and hardware drivers used.

On macOS, the default number of processor cores used by COMSOL 
Multiphysics is the total number of available physical cores. For example, if you 
have a 2 x dual core machine, 4 cores are used in parallel by a COMSOL process.

SHARED-MEMORY OPTIONS

From the terminal window, use the comsol command option -np to control the 
number of cores and processors used. The default is to use all available cores and 
processors. For example:

comsol -np 2

launches COMSOL using 2 cores (if available).
You can experiment to find the options that work best for your configuration. For 
more information see the COMSOL Multiphysics Reference Manual.

Running COMSOL Multiphysics on Clusters

You can launch COMSOL Multiphysics cluster jobs from the COMSOL Desktop 
and the command line. To run COMSOL Multiphysics on a cluster, you need to 
make the cluster feature visible: in the Model Builder tree, click the Show More 
Options button ( ) and select Batch and Cluster in the Show More Options dialog. 
Then in the Model Builder, right-click a Study node and select Cluster Computing 
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or Cluster Sweep to create cluster jobs. Cluster computing requires a Floating 
Network License.

A tutorial model for cluster testing is included in the Application Libraries window 
under COMSOL Multiphysics/Cluster_and_Batch_Tutorials/micromixer_cluster.
For more information about how to run COMSOL Multiphysics in parallel on 
clusters, see the COMSOL Multiphysics Reference Manual. For installation on 
Clusters, see Cluster Installation for Windows and Cluster Installation for Linux.

Running COMSOL Multiphysics on the Cloud

COMSOL Multiphysics and COMSOL Server support cloud computing. See
• www.comsol.com/partners-consultants/hpc
• www.comsol.com/model/

running-the-comsol-software-with-amazon-ec2-14075
• www.comsol.com/model/

running-the-comsol-software-with-microsoft-azure-89751

COMSOL Multiphysics cannot be run on a cluster running 
macOS Intel; however, you can use the Cluster Computing or 
Cluster Sweep feature to connect to a Windows, Linux, or macOS 
ARM64 cluster.
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Installing on Linux

Instal lation Over the Internet

INSTALLATION OF A TRIAL LICENSE OVER THE INTERNET

A trial license can be given to you with the intention to test the software without 
any payment obligation for noncommercial and nonproduction use. This option 
is not available in all regions.
Installation of a Single User Trial License requires a license passcode. A passcode 
has a form similar to FFFFFFFF-TYUS-123456-1234567-123456789.
This is usually sent to you by your COMSOL representative by email. Once you 
locate your passcode, follow these steps to prepare for download and installation:
1 Click the link for downloading the software as given in the software download 

email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.

2 If you have not already created a COMSOL Access account, you are prompted 
to create it. When you have created the account, you can enter your license 
passcode to associate it with your account information.
If you already created a COMSOL Access account, you can associate the license 
file with your account on the COMSOL Access page under Manage Licenses at 
www.comsol.com/access/licenses.

3 Follow the web-based instructions to download the software.

A license passcode can also be used for class kit licenses (CKL).
Continue with the instructions in the section Downloading and Installing the 
COMSOL Software.

INSTALLATION OF A PAID-FOR OR TRIAL LICENSE OVER THE INTERNET

Installation of any paid-for license on Linux requires a license file, which is sent to 
you by your COMSOL representative by email. To be able to generate the license 
file, information about your hardware is needed in the form of a hostid (host ID). 
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The hostid is used to lock the license to your hardware and needs to be sent by 
you to a COMSOL representative prior to the license file being generated.

Obtaining the Hostid
Follow these steps to obtain a hostid:
1 Start a Terminal window.
2 Enter cat /sys/class/net/*/address

This displays all physical Ethernet addresses (also called MAC addresses) which 
consists of six bytes displayed as six pairs of hexadecimal digits such as 
00:40:05:16:E5:25. Choose one that does not consist of zeros only.

Obtaining the Hostname
If you have been informed by a COMSOL representative that you need to run a 
license manager for your installation, then you also need the hostname:
1 To get the hostname, start a Terminal window.
2 Enter hostname at the terminal prompt.
If your network administrator prefers to use a fixed IP address for this particular 
computer, this IP Address can be optionally used in place of the hostname. For 
more information on license manager installation see License Manager Installation 
on Linux.

Obtaining the License File from a COMSOL Representative
Send the hostid information, as well as hostname, if applicable, in an email to your 
COMSOL representative, who responds by email including an attached license file 
(license.dat). Save this file to any location on your computer. You need to refer 
to it during installation. A trial license file for Linux cannot normally be edited or 
changed in any way by the user but has to be identical to the one sent to you by a 
COMSOL representative. However, if you were sent a license file that requires a 
license manager, then minor edits are required. For information on the type of 
license file required for installations using a license manager, see The License File.

Registering with COMSOL Access
Once you have saved your license file, follow these steps to register or login to 
COMSOL Access and to start the installation:

A trial license can be given to you with the intention to test the 
software without any payment obligation for noncommercial or 
nonproduction use. This option is not available in all regions. For 
installation of a Single User Trial License on Linux, you can follow 
the same instructions as for a paid-for license.
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1 Click the link for downloading the software as given in the software download 
email from your COMSOL representative. This link is identical or similar to: 
www.comsol.com/product-download.

2 If you have not already created a COMSOL Access account, you are prompted 
to create it. While creating the account, point to your license file (license.dat) 
to associate it with your account information.
If you already created a COMSOL Access account, then you can associate the 
license file on the COMSOL Access page with your account under Manage 
Licenses at www.comsol.com/access/licenses.

3 Continue with the instructions in the section below.

Downloading and Instal l ing the COMSOL Software

1 Go to the web page www.comsol.com/product-download. To download the 
COMSOL installer, you must first create a COMSOL Access account as 
described in the section Installation over the Internet.

2 You are now given the options of downloading the COMSOL online installer 
or the COMSOL offline installer (a DVD image).

STARTING THE ONLINE INSTALLER FOR INSTALLATION OVER THE INTERNET

The COMSOL Installer is a user interface tool that guides you through the 
installation process. The file to download is called comsol64_lnx.zip. Start the 
COMSOL Installer by extracting the downloaded file and then running the setup 
script. The COMSOL 6.4 Installer window should now appear. Next, continue 
with the instructions in the section Running The COMSOL Installer. below.

If you have problems downloading (such as Error downloading file. 

Connection refused: connect), please review this knowledge base 
entry: www.comsol.com/support/knowledgebase/1149. If you 
still have problems, contact your local COMSOL representative or 
technical support from the Support Center page 
www.comsol.com/support.
 | 103

https://www.comsol.com/support/knowledgebase/1149
https://www.comsol.com/support
https://www.comsol.com/product-download
https://www.comsol.com/access/licenses
https://www.comsol.com/product-download


INSTALLATION FROM DOWNLOADED DVD IMAGE

1 Download the DVD image(s). The default image, COMSOL64_dvd.iso, is too 
large to burn to disc and must be mounted directly. For installations that require 
physical discs, download the files COMSOL64_dvd_1.iso, COMSOL64_dvd_2.iso, 
and COMSOL64_dvd_3.iso instead.

2 When you have downloaded the DVD image(s), mount the single image 
directly or burn the numbered images to discs. To directly mount the image, 
you can use a loopback device:

mount -o loop,exec COMSOL64_dvd.iso /mnt

STARTING THE INSTALLER FROM A DVD OR MOUNTED DVD IMAGE

The COMSOL Installer is a user interface tool that guides you through the 
installation process. To start the installer:
1 Make sure the COMSOL DVD is in the DVD drive (or mount the image).
2 Type /mnt/setup
The COMSOL 6.4 Installer window appears. Now continue with the instructions 
in the section Running The COMSOL Installer below.

Instal l ing from a DVD

This section applies if you have received a DVD from a COMSOL representative.
The COMSOL Installer is a user interface tool that guides you through the 
installation process. To start the installer:
1 Insert the COMSOL 6.4 DVD into the DVD drive.
2 If the DVD is not mounted automatically by your operating system, use the 

mount command to mount it.
3 To start the installation, enter the command:
<drivepath>/setup

where <drivepath> is the mount point of the DVD drive, for example
/media/cdrom

You might have to mount the DVD with the option -o exec if your Linux 
distribution mounts the DVD without execute options by default.

The COMSOL 6.4 Installer window appears. Now continue with the instructions 
in the section Running The COMSOL Installer below.
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Instal lation from USB Flash Drive

If you have received a USB Flash Drive from a COMSOL representative:
1 Connect the USB Flash Drive to your computer.
2 If the USB Flash Drive is not mounted automatically by your operating system, 

use the mount command to mount it.
3 To start the installation, enter the command:
<drivepath>/setup

where <drivepath> is the mount point of the USB Flash Drive, for example
/media/usb

You might have to mount the USB Flash Drive with the option -o exec if your 
Linux distribution mounts the drive without execute options by default.

4 The COMSOL 6.4 Installer window appears. Now continue with the 
instructions in the section Running The COMSOL Installer below.

Running The COMSOL Instal ler

The steps for running the COMSOL Installer are independent of the installation 
media option you use. If you have followed the above instructions, the COMSOL 
Installer should now appear. For a detailed description and screenshots of the 
different COMSOL Installer steps, see the instructions for Windows in the section 
Running the COMSOL Installer. The procedure for running the COMSOL 
Installer on Linux is similar and summarized below with the differences from 
installation on Windows highlighted:
1 When the installer window appears, click New Installation.
2 Read the license agreement, select I accept the terms of the license agreement, 

specify License information, and then click Next.
3 If you have a Named Single User License and you are installing the software on 

the license server, a dialog opens up and you are asked to enter the username to 
bind the license to.

4 Select the products to install and specify the path to the COMSOL installation 
directory. Installing in the default path requires administrative rights.

5 Click Next.
6 If you have licensed LiveLink™ for MATLAB® or LiveLink™ for Simulink®, then 

specify the MATLAB root folder.
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7 Click Next.
8 Click Install to start the installation.
9 When the installation process is finished, the Finish window appears. If errors 

arose during installation, this window issues a notification. The installer also 
writes a log entry into the text file comsolsetup.log, which resides in the 
specified installation directory. Click Close to quit the installer. If you installed 
from DVD, use the unmount and eject commands to unmount and eject the 
DVD. Some Linux configurations automatically unmount and eject the DVD 
when you press the DVD drive button.

10 To make sure all users can easily start COMSOL Multiphysics, include the 
comsol64/bin directory in all users’ paths or make a symbolic link from /usr/
local/bin/comsol to the comsol command (see the Linux ln command). The 
installer can do this step automatically if you run the installer as an 
administrator.

Web Browser for Viewing Documentation and Help

By default, documentation is shown in the Documentation window and context 
help in the Help window integrated in the COMSOL Desktop. If you prefer to use 
an external browser, you can specify this on the Help page of the Preferences 
window.
You can choose your preferred web browser in two ways:
• In the Executable field on the User Interface page of the Preferences window.
• If no browser executable has been specified, the browser to use is 

determined by the script browser in the bin directory. The variable BROWSERS 
in this file contains a list of web browsers that are available with the 
supported Linux versions in order of preference. Edit the file in any text 
editor to adjust it for your preferred web browser. To make a specific 
browser the preferred web browser, put it first in the list.

You may also need to install the fonts (using the normal Linux 
distribution methods) for the languages that you want to use 
when running COMSOL Multiphysics.
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Automated Instal lation

You can install the COMSOL software using an automated installation process 
with minimal user interaction. This method requires installation from a DVD or 
DVD image and an answer file.
The answer file is a text file with a specific format that contains predefined settings 
for the COMSOL installer. If non-ASCII characters are used, the answer file is 
expected to be UTF-8 encoded by default, but UTF-16 is also supported if the 
file starts with a byte order mark (BOM).
A template answer file, setupconfig.ini, with detailed usage information is 
available on the DVD. Create a copy of this file and customize it with a text editor.
When the answer file is ready, start the installation by running
<drivepath>/setup -s <answerfile>

where <drivepath> is the media mount point, and where <answerfile> is the 
complete path to your answer file.

Removing (Uninstal l ing) the COMSOL Instal lation

To remove a COMSOL installation from your system, you can use the COMSOL 
Installer’s uninstallation option. This removes all the files and directories that were 
initially created by the COMSOL Installer. Files and directories that were created 
or modified after the installation are not removed.
You can start the COMSOL Uninstaller in a few different ways:
• Launch the COMSOL Installer using the same method as for the original 

installation, and select Uninstall COMSOL 6.4.
• In a terminal window, run the following command:

/usr/local/comsol64/multiphysics/setup uninstall

Alternatively, to remove the COMSOL installation, delete the comsol64 folder 
including all subfolders and the following files if they exist:

/usr/local/bin/comsol
/usr/local/bin/comsol-6.4
/usr/share/applications/comsol-multiphysics-6.4.desktop
~/.local/share/applications/comsol-multiphysics-6.4.desktop
/usr/lib/systemd/system/lmcomsol.service
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Product Updates and Application Library Update

COMSOL periodically releases product updates with improvements and 
corrections to reported problems. By default, COMSOL does not check for 
updates at startup. You can turn this feature on and off from the Preferences 
window accessible from the COMSOL Desktop. Here you can also configure 
settings for the Application Library Update.
The COMSOL Application Library is updated on a regular basis by COMSOL. 
To open the Application Library Update window, from the Help menu, select Update 
COMSOL Application Libraries.
This connects you to the COMSOL Application Update website where you can 
access the latest updates. This includes applications that have been added or 
improved since the latest product release.
Using the Updates section in the Preferences window, which you open from the 
COMSOL Desktop, you can configure proxy server settings as well as application 
and documentation directories for the Application Library Update. See the 
COMSOL Multiphysics Reference Manual for more information including 
command-line options for the Application Libraries.

AUTOMATED UPDATES

You can update the COMSOL software using an automated update process with 
minimal user interaction using the abovementioned DAT-file. Consult 
www.comsol.com/product-update for detailed instructions.

Changing the Path to the MATLAB® Instal lation

You can change the path to the MATLAB installation in the Preferences > LiveLink 
Connections window accessed from the Options menu of the COMSOL Desktop. 
For more information, see the LiveLink™ for MATLAB® documentation.

Cluster Instal lation

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
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including cluster support. This section is dedicated to distributed-memory parallel 
installation.
COMSOL Multiphysics can distribute computations on compute clusters using 
the MPI model. One large simulation can be distributed across many compute 
nodes. Also, parametric sweeps can be done with individual parameter cases 
distributed to each cluster node.

SYSTEM REQUIREMENTS

The installation instructions above can also be followed for clusters. COMSOL 
supports shared-memory parallelism and distributed-memory parallelism on 
Linux. For details on system requirements, including additional software packages 
required for certain configurations, see www.comsol.com/system-requirements.

LICENSE MANAGER

COMSOL Multiphysics requires a Floating Network License for running on 
clusters. Please check the license file for the CLUSTERNODE feature, which needs to 
be present to enable the cluster computing functionality. The license manager 
needs to be accessible from all nodes in the cluster. Therefore it is often a good 
idea to have it run on the head node.

INSTALLATION FOLDER

The COMSOL installation folder should be shared between all compute nodes 
and the head node.

FEATURES

During installation, make sure the Cluster Components feature is selected.

ACCESS TO CLUSTER

If you work on a computer that is not on the cluster, install COMSOL 
Multiphysics on that computer. Typically, you use a scheduler to launch jobs on 
the cluster. Make sure the scheduler client software is installed on that computer. 
You can configure the installation to use the scheduler by changing the 
comsol.ini file according to the section on MPI Options in the COMSOL 
Multiphysics Reference Manual.
For more information on installing and running COMSOL on clusters, see 
Running COMSOL on Clusters and the COMSOL Multiphysics Reference 
Manual.
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License Manager Installation on Linux

Many of the instructions for installing the license manager are similar to those for 
Windows. This section only covers the differences for Linux installations. For 
more information, see License Manager Installation on Windows.

FlexNet® License Manager Software Components

The license manager consists of the following software components:
• License server manager (lmgrd)
• Vendor daemon (LMCOMSOL)
• FlexNet utility programs (lmutil and others)

The license server manager (lmgrd) and the vendor daemon (LMCOMSOL) run on the 
license server. When a user starts COMSOL on a client computer, communication 
is established through the network from the client to the license server and the 
license server manager (lmgrd). The license server manager then makes a request 
to the vendor daemon (LMCOMSOL), which releases licenses according to 
information in the license.dat file. The FlexNet utility programs are used for 
handling license server management tasks.

FlexNet® License Manager Documentation

For detailed information on the FlexNet® license manager software, select Help > 
Documentation in the COMSOL Desktop and scroll to the bottom of the page to 
locate a PDF copy of the FlexNet Publisher License Administration Guide.
Note: This PDF file is only available if you have locally installed documentation.
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The License Fi le

The license file for use on Linux is identical to that for Windows, except in the case 
of a Named Single User License, which is described below. See The License File 
and The License Features for general license file information.

LICENSE FILES FOR NAMED SINGLE USER LICENSE

If you have a named single user license, the installer automatically creates an 
options file that binds the license to the named user. This section describes the 
format of the options file and how the license.dat file points to the options file.
Below is an example of an options file, LMCOMSOL.opt, for a user “philip” who has 
access to COMSOL Multiphysics, the Structural Mechanics Module, and the 
CAD Import Module. Notice that to access COMSOL Multiphysics, the options 
file must include both the COMSOL and the COMSOLGUI features:

INCLUDE COMSOL USER philip
INCLUDE COMSOLGUI USER philip
INCLUDE CADIMPORT USER philip
INCLUDE CADIMPORTUSER USER philip
INCLUDE CADREADER USER philip
INCLUDE STRUCTURALMECHANICS USER philip

Each INCLUDE row in the LMCOMSOL.opt file has a corresponding FEATURE row in the 
license.dat file (with the USER_BASED keyword). The second item on each 
FEATURE row is the name of the feature for which you have a license.
For more information on which FEATURE items are available, see The License File 
and The License Features.
The license.dat file needs to point to the options file. The path to the options 
file is indicated by the options keyword. If your options file is placed here:

/usr/local/comsol64/multiphysics/license/LMCOMSOL.opt

then the VENDOR row in license.dat should read
VENDOR LMCOMSOL port=1719 options=/usr/local/comsol64/multiphysics/
license/LMCOMSOL.opt

Instal l ing the License Manager

The license manager components are automatically installed when installing the 
COMSOL software unless otherwise specified on the Products page of the 
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COMSOL installer; see Products Page. The checkbox for the license manager 
components can be found last in the list of software components.
If you want to install COMSOL on the same computer as the license manager and 
you did not choose to install the license manager as a service, first perform a 
complete COMSOL installation including the license manager software 
components.
If you want to install the license manager on a computer where running the 
COMSOL Installer is inconvenient, please contact COMSOL Support for access 
to the files needed for installing only the license manager.

LICENSE MANAGER PAGE

See License Manager Page for information about the license manager settings in 
the installer. For Linux, this page also contains some additional settings:
• In the User to run license manager field, enter the username for the user on 

the computer that will run the license manager. If this field is empty, the root 
user runs the license manager, which is not recommended from a security 
point of view.

• Optionally, specify a group the user belongs to in the Group of the user field.

Note: The License Manager page only appears if the installer is started by a 
superuser (such as root or by using sudo) on a system that uses systemd.
112 | 



To install only the license manager, follow the installation instructions for 
COMSOL earlier in this document, and on the Products page, clear all 
checkboxes except the one for the license manager.
When finished, skip the remainder of this section and continue with Starting the 
License Manager below.

AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation 
process with minimal user interaction, see Automated Installation. Set 
licmanager = 1 in the answer file to install the license manager. It is also possible 
to automatically configure the license manager to run on systemd-based Linux 
distributions. Use licmanager.service = 1 in the setupconfig.ini file and 
provide values for the other licmanager.service.* lines.

Starting the License Manager

You can start the license manager manually or it can run automatically at boot.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually, make the license/$arch directory the 
current directory and enter

./lmgrd -c ../license.dat -l /var/tmp/comsol64.log

The server is now ready to distribute licenses over the network. It writes any debug 
information to the log file /var/tmp/comsol64.log.

STARTING THE LICENSE MANAGER AUTOMATICALLY AT BOOT

In order for the license manager to start automatically at boot, you need to add 
shell commands to the appropriate boot script. You must be a superuser (root) to 

The installer can set up the license manager to start automatically; 
in case it did, you can skip the following section.
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edit boot scripts. In some cases, however, the COMSOL Installer automatically 
installs and configures the license manager.

systemd-Based Systems
For Linux distributions that use systemd, use the lmcomsol.service file, located 
in the comsol64/license/glnxa64 or comsol64/license/glnxarm64 directory, to 
start the license manager. To use lmcomsol.service, do the following steps:
1 Update the paths to lmgrd, license.dat, and comsol64.log in case you have 

different locations for these files.
2 Optionally, replace username with an actual username. Preferably do not use 

root; instead, use the account used to install COMSOL or another account with 
access to both the lmgrd executable and the log file location above.

3 Create a /usr/tmp directory if it does not exist and set its permissions to 1777 
with the chmod 1777 /usr/tmp command.

4 If you already have the license manager installed using systemd, stop the 
previous version of it by typing systemctl stop lmcomsol.

5 Copy the lmcomsol.service file to /usr/lib/systemd/system/ and run the 
systemctl enable lmcomsol and systemctl start lmcomsol commands to 
activate the license manager.

Verifying That the License Manager Is Running

Once you start the license manager, it is good practice to verify that the license 
manager processes are running. Use administrative commands such as top or ps to 
check that both the vendor daemon (LMCOMSOL) and the license server manager 
(lmgrd) are running. On Linux distributions that use systemd, if the license 

For security reasons, it is recommended that the daemons are not 
started as root. Instead, use a dedicated username to start the 
license manager.

If you obtained the license server binaries through COMSOL 
support and run SELinux on your system, make sure to unzip the 
binaries under /usr/local.
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manager is installed as a service according to the instructions, you can run service 
lmcomsol status instead.

Starting COMSOL Multiphysics

After the installation is complete and the license manager is running on the license 
server, you can start using COMSOL Multiphysics. For more information on how 
to run COMSOL Multiphysics, see Running COMSOL Multiphysics on Linux.

Changing the License

If you have received a new license file — for example, when adding COMSOL 
products to an existing license — replace the current license file with the new one. 
Double-check the contents of this file to make sure it lists the products that the 
license includes.

RESTARTING THE LICENSE MANAGER

To restart the license manager, make the license/$arch directory under the 
COMSOL installation directory the current directory, then enter the following 
commands:

./lmdown -c ../license.dat

./lmgrd -c ../license.dat -l /var/tmp/comsol64.log

When installed as a service on Linux distributions with systemd according to the 
instructions, you stop it with the service lmcomsol stop command and start it 
with the service lmcomsol start command.

OBTAINING A HOSTID

If the COMSOL software is already installed on your license server, you can 
determine the hostid by executing the lmhostid command:

When the license file has been changed, you must restart the 
license manager or reread the license file; otherwise, it continues 
to use the old license file still in memory.
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comsol64/multiphysics/license/glnxa64/lmhostid

or
comsol64/multiphysics/license/glnxarm64/lmhostid

depending on your CPU architecture.

Using COMSOL on an IPv6 Network

COMSOL has been tested on both IPv6-only networks and hybrid IPv4/IPv6 
networks. To make sure that the license manager uses IPv6 for communication, 
set the environment variable FNP_IP_PRIORITY to 6. See the FlexNet License 
Administration Guide for details.

Troubleshooting License Errors

If you have questions or problems with your installation, see Troubleshooting 
License Errors.
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Running COMSOL Multiphysics on Linux

Running COMSOL Multiphysics

If you are running a Linux version with a graphical desktop environment, you 
might find a COMSOL Multiphysics icon that you can simply click to start 
COMSOL Multiphysics in the menus. Alternatively, using a terminal window, you 
can run the comsol command. If it is not available, ask your system manager to 
make it available to you, or, if you have administrative privileges on your Linux 
system, add the comsol command to the search path. The setup can do this 
automatically for you during installation if you run it with root privileges. The 
comsol command is located in the bin folder in the COMSOL installation 
directory. This is a typical example of a command that adds comsol to the search 
path (assuming you are logged in as root):

ln -s /usr/local/comsol64/multiphysics/bin/comsol /usr/bin/comsol

Multicore Settings

COMSOL Multiphysics supports two modes of parallel operation: 
shared-memory parallel operations and distributed-memory parallel operations, 
including cluster support for Windows and Linux. This section covers 
shared-memory processing, or multithreading, which is important for the 
performance of COMSOL Multiphysics computations. Some terms that are 
frequently used in when describing multithreading are:
• Core: The core is a processor core used in shared-memory parallelism by a 

computational node with multiple processors.

In order for the help system to work on Linux, some packages 
need to be installed; for details, see www.comsol.com/
system-requirements.
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• Speedup is how many times faster a job runs on N cores compared to 1 core, 
on a specific compute node. The speedup depends on the simulation type, 
the hardware used, and the hardware drivers used.

On Linux, the default number of processor cores used by COMSOL Multiphysics 
is the total number of available physical cores. For example, if you have a 2 x dual 
core machine, 4 cores are used in parallel by a COMSOL process.

SHARED-MEMORY OPTIONS

From the Terminal window, use the comsol command option -np to control the 
number of cores and processors used. The default is to use all available cores and 
processors. For example:

comsol -np 2

launches COMSOL Multiphysics using 2 cores (if available).
You might need to experiment to find the options that work best for your 
configuration. For more information see the COMSOL Multiphysics Reference 
Manual.

Running COMSOL Multiphysics in Batch Mode

You can submit COMSOL Multiphysics batch jobs from the COMSOL Desktop 
and the command line.
To run a COMSOL Multiphysics batch job from the COMSOL Desktop, you 
need to make the Batch feature visible: in the Model Builder tree, click the Show 
More Options button ( ) and select Batch and Cluster in the Show More Options 
dialog. In the Model Builder, right-click a Study node and select Batch to create 
batch jobs.
From a terminal window, you can start batch jobs using the comsol batch 
command. This is an example of such a command:

comsol batch -inputfile in.mph -outputfile out.mph

To run a specific study add the command line option -study <tag>, where <tag> 
is the tag of the study to run, for instance, std1. To see the tag, click the toolbar 
button Model Tree Node Text in the Model Builder and select Tag.
The COMSOL Multiphysics Reference Manual has a dedicated section on 
running COMSOL Multiphysics from a terminal window, including a list of 
COMSOL commands and associated syntax.
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Running COMSOL Multiphysics in Client–Server Mode

When you start COMSOL Multiphysics by, for example, entering the comsol 
command with no additional arguments, COMSOL Multiphysics is run as a single 
application that includes the functionality of both the COMSOL Multiphysics 
client and COMSOL Multiphysics server, as explained later in this section. 
However, the COMSOL client–server architecture lets you access the COMSOL 
Multiphysics server — the COMSOL computational engine — as a separate 
process. For example, the COMSOL Desktop can act as a COMSOL Multiphysics 
client when connected to a COMSOL Multiphysics server.

You need a Floating Network License to run the COMSOL Multiphysics server 
and the COMSOL Multiphysics client on separate computers. However, any 
COMSOL license is sufficient for running the client and the server on the same 
computer.
The client and server need not run on the same platform. For example, you can 
run the COMSOL Desktop on Windows connecting to a COMSOL Multiphysics 
server on a Linux computer. This enables offloading heavy-duty computations 
from your personal laptop or desktop to run just the COMSOL Desktop graphical 
user interface. A typical use would be to run the COMSOL Multiphysics server on 
a computer with large amounts of memory (RAM) and processing power and to 
use your personal computer for pre- and postprocessing with the COMSOL 
Desktop.

STARTING A COMSOL MULTIPHYSICS SERVER

To start the COMSOL Multiphysics server from a terminal window, run the 
comsol command with the mphserver argument:

comsol mphserver

You are then prompted for a username and password. You can use any username 
and password of your choice, it is only used for connecting a COMSOL 
Multiphysics client with a COMSOL Multiphysics server.
When the COMSOL Multiphysics server starts, it listens for a COMSOL 
Multiphysics client connection on the port listed in the command window.

The license server is not the same as a COMSOL Multiphysics 
server. The license manager can run on a computer different from 
both the ones used by COMSOL Desktop and COMSOL 
Multiphysics server.
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Connecting a COMSOL Multiphysics Client to a COMSOL Multiphysics Server
You can start a COMSOL Multiphysics client session from the COMSOL 
Desktop by selecting Connect to Server from the File menu in the COMSOL 
Desktop. You can also start a COMSOL Multiphysics client session from a 
terminal window by running the comsol command with the client argument:

comsol client

When you start the client, a Connect to COMSOL Multiphysics Server window 
appears prompting you for a computer name (Server) where the COMSOL 
Multiphysics Server is running, Port number, Username, and Password:

Once you have filled out this information and clicked OK, the COMSOL 
Multiphysics server terminal window displays information that a COMSOL 
Multiphysics client has connected. For more information on running COMSOL 
in client–server mode, see the COMSOL Multiphysics Reference Manual.

Running a Classkit License

To start COMSOL Multiphysics using a Classkit License, start COMSOL 
Multiphysics using the -ckl option:

comsol -ckl

Running COMSOL on Clusters

You can launch COMSOL Multiphysics cluster jobs from the COMSOL Desktop 
and the command line.
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To run COMSOL Multiphysics on a cluster from the COMSOL Desktop, you 
need to make the cluster feature visible: in the Model Builder tree, click the Show 
More Options button ( ) and select Batch and Cluster in the Show More Options 
dialog. Then in the Model Builder, right-click a Study node and select Cluster 
Computing or Cluster Sweep to create cluster jobs. Cluster computing requires a 
Floating Network License.
The following terms occur frequently when describing the hardware for cluster 
computing and shared memory parallel computing:
• Compute node: The compute nodes are where the distributed computing 

occurs. Each distributed COMSOL process resides in a compute node and 
communicates with other compute nodes using MPI (message-passing 
interface).

• Host: The host is a physical machine (hardware) with a network adapter and 
unique network address. The host is part of the cluster. It is sometimes 
referred to as a physical node.

• Core: The core is a processor core used in shared-memory parallelism by a 
computational node with multiple processors.

The number of used hosts and the number of computational nodes are usually the 
same. For some special simulation types, like very small simulations with many 
parameters, it might be beneficial to use more than one computational node on 
one host.
A tutorial model for cluster testing is included in the Application Libraries window 
under COMSOL Multiphysics/Cluster_and_Batch_Tutorials/micromixer_cluster.

QUICK TROUBLESHOOTING

• First, ensure that you have the latest release installed. Check that you have 
COMSOL 6.4 or later and make sure to install the latest product updates.

• If you get the error message Process status indicates that process is running, 
then cancel any running jobs in the scheduler that you use. In the COMSOL 
Desktop, locate the External Process page at the lower-right. Click the Clear 
Status button.

For more information about how to run COMSOL Multiphysics in parallel on 
Linux clusters, see the COMSOL Multiphysics Reference Manual. For installation 
on Clusters, see Cluster Installation.
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Running COMSOL Multiphysics on the Cloud

COMSOL Multiphysics and COMSOL Server support cloud computing. See
• www.comsol.com/partners-consultants/hpc
• www.comsol.com/model/

running-the-comsol-software-with-amazon-ec2-14075
• www.comsol.com/model/

running-the-comsol-software-with-microsoft-azure-89751

Running COMSOL Multiphysics with MATLAB

Running COMSOL Multiphysics with MATLAB starts a COMSOL Multiphysics 
server and a MATLAB Desktop. No COMSOL graphical user interface is 
involved. For a tutorial, see the LiveLink for MATLAB User’s Guide.
To launch MATLAB and connect it to a COMSOL Multiphysics server, run the 
command

comsol mphserver matlab

STARTING COMSOL MULTIPHYSICS WITH MATLAB USING THE GRAPHICS 

SERVER

To display the plot in a COMSOL graphics window you need to run COMSOL 
with MATLAB using the graphics server. To do so, start COMSOL with 
MATLAB from a terminal window with the -graphics flag:

comsol mphserver matlab -graphics

REQUIRED PROGRAMS FOR RUNNING COMSOL WITH MATLAB
The xterm program is necessary for the command comsol mphserver matlab. The 
csh program is needed to call MATLAB functions from COMSOL Multiphysics.
• To install the missing packages on Debian and Ubuntu, type

sudo apt-get install xterm csh

• To install the missing packages on RedHat Enterprise and Fedora, type
sudo yum install xterm tcsh

• To install the missing packages on OpenSUSE, type
sudo zypper install xterm tcsh
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Running COMSOL Multiphysics with Simulink

Running COMSOL Multiphysics with Simulink starts a COMSOL Multiphysics 
server and a MATLAB Desktop. The COMSOL graphical user interface is not 
started. For a tutorial, see the Introduction to LiveLink for Simulink manual.
To launch MATLAB and connect it to a COMSOL Multiphysics server, run the 
command

comsol mphserver simulink

Note that the Simulink window is not opened by this command.

REQUIRED PROGRAMS FOR RUNNING COMSOL WITH SIMULINK

The xterm program is necessary for the command comsol mphserver simulink.
• To install the missing packages on Debian and Ubuntu, type

sudo apt-get install xterm

• To install the missing packages on RedHat Enterprise and Fedora, type
sudo yum install xterm

• To install the missing packages on OpenSUSE, type
sudo zypper install xterm
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COMSOL Security

COMSOL Multiphysics Client–Server Security

The COMSOL Multiphysics client–server architecture lets you access the 
COMSOL Multiphysics server — the computational engine in COMSOL 
Multiphysics — as a separate process. COMSOL Multiphysics client–server uses a 
TCP/IP connection to send data between client and server. The COMSOL 
Multiphysics server is a single-user server. The design of COMSOL Multiphysics 
client–server assumes that you, the user, start both the client and the server 
manually. You are responsible for setting a password for mutual authentication of 
the client and server. The COMSOL Multiphysics client–server architecture is 
designed to operate in a secure environment and has only basic security 
incorporated in its design.
You can also access a COMSOL Multiphysics server with the COMSOL API client 
in a Java method running in a separate process or a process on a separate computer. 
This happens, for example, in the LiveLink™ for MATLAB®, where MATLAB® 
loads the COMSOL API client and launches a separate process with the 
COMSOL Multiphysics server.

PASSWORD SECURITY

You can control if the client–server password is stored on file between sessions. In 
the COMSOL Multiphysics client, select the Remember username and password 
checkbox in the Connect to COMSOL Multiphysics Server dialog to store the 
password between sessions. In the COMSOL Multiphysics server, by using the 
option -passwd nostore, you can avoid storing the password on file. If you do not 
provide the option, the password will be stored on file, and you will not be asked 
to provide it when you start a new server session.
Before storing your password on file, it is hashed by the SHA256 algorithm. This 
means that an adversary that gets access to your password file will not easily be able 
to obtain the password you originally entered. However, if an adversary gets access 
to your password file, the adversary could login on a COMSOL Multiphysics 
server started by you, or, potentially, have you log in on a hostile COMSOL 
Multiphysics server.
By default, both the COMSOL Multiphysics client and the COMSOL 
Multiphysics server write the hashed password to the file .comsol/v64/
124 | 



login.properties in your home directory. Both COMSOL Multiphysics client 
and server will attempt to make the password file inaccessible for other users by 
introducing access restrictions. When you use the client and server on the same 
computer there will only be a single password file by default. This could also 
happen if you run the client and server on separate computers, if your home 
directory is located on a shared network drive.
You should avoid storing your client–server password on file if your home 
directory is located on a network drive that does not encrypt network traffic. If 
your password is stored on a local drive, your client–server password security will 
be improved if the drive is encrypted. Generally, a user with administrative access 
to your computer could get access to your password file.
The COMSOL Multiphysics client–server is designed to protect your password 
file during network traffic between client and server (see the next section).

TCP/IP CONNECTION

The TCP/IP communication between client and server is not encrypted. 
However, the server and client are mutually authenticated using a challenge 
handshake authentication protocol (CHAP), which means that the client–server 
password cannot be easily obtained by an adversary that can eavesdrop the 
network traffic between client and server.
The TCP connection between the client and the server is otherwise not encrypted. 
If you require encryption of the TCP connection, you can use third-party software 
based on protocols such as SSH or IPSEC and tunnel the client–server traffic. 
When doing this you may need access to the port number used for client–server 
communication. The port number is 2036 by default but can be controlled and 
modified both from the client and the server.

COMSOL MULTIPHYSICS SERVER SECURITY

When running COMSOL Multiphysics client–server operations from the client, 
file system access is typically performed on the client. However, COMSOL 
Multiphysics client can potentially access files on the file system and other 
operating system resources on the server computer with the same privileges as the 
user that launched the Multiphysics server. The COMSOL Multiphysics client–
server security design assumes that the same physical user is operating both the 
client and the server and that this user is not an adversary.
In particular, when using the COMSOL API on the client computer, you should 
avoid running Java methods, or MATLAB functions with the LiveLink for 
MATLAB, that have not been reviewed from a security point of view. Some 
operations on the COMSOL Multiphysics server will read and write files on the 
client and server computer, and other operations may run operating system 
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commands or initiate network traffic on the client or server computer. These 
operations are performed with the same privileges as the user that started the 
COMSOL Multiphysics client or server.
When running model methods or add-ins in for COMSOL Multiphysics client–
server, these are run using the security settings for applications (see the next 
section).

Application and Physics Builder Security

Models and applications can be protected with the AES256 encryption algorithm 
using passwords for running and editing. For applications without a running 
password, the model or application is decrypted using a secret but hard-coded 
password. To achieve the highest security, use both an editing and a running 
password.
Protecting a model or application only encrypts the XML data structure that 
represents the Model Builder and the Application Builder data structures. 
Auxiliary data structures describing the geometry, mesh, and solution are not 
encrypted.
Compiled physics builder files are obfuscated with the AES256 encryption 
algorithm using a hard-coded password.

Method Security

You can use the Application Builder to write Java methods that are run from 
applications, model methods, and add-ins. When you run those methods, the 
privileges of the methods are controlled by the security settings that you find in 
the Preferences window under Security in the COMSOL Multiphysics desktop.
The security settings will apply to all applications, model methods, and add-ins 
that you load in COMSOL Multiphysics.
Note that any MPH file may contain applications, model methods, and add-ins. If 
you intend to load an MPH file from an unreliable source, you should enable all 
security features. You can do that by reverting to Factory Settings and clearing all 
checkboxes under General in the security settings, and finally clicking OK.
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SECURITY SETTINGS

If your MPH files come from reliable sources or you make them yourself, you can 
keep the factory settings for security. If you write methods that require additional 
system access, you can give methods more privileges, but you should revert to the 
original settings if the situation changes. Find a general description of the security 
settings in the section Security Settings in the COMSOL Multiphysics Reference 
Manual.

ADD-IN SECURITY

For add-ins that require extended privileges permanently, you can disable all 
security settings for certain methods in the add-in by using the comsoltrust 
command. This command makes it possible to maintain restricted security settings 
for applications generally but allow certain adds-in to operate.

EMAIL PASSWORD

When your password to the SMTP email server is stored as preference, the 
behavior is operating system dependent.

Windows
The password is encrypted using the built-in Windows data protection mechanism 
for the current user. The encrypted password is stored in the preference files 
%USERPROFILE%\.comsol\v64\comsol.prefs and 
%USERPROFILE%\.comsol\v64\comsolserver.prefs.

Mac and Linux
The password is encrypted using an autogenerated password. The encrypted 
password is stored in the preference files $HOME/.comsol/v64/comsol.prefs and 
$HOME/.comsol/v64/comsolserver.prefs. The autogenerated password is stored 
in the read-protected file $HOME/.comsol/v64/prefskeyserver.properties.

COMSOL Server Security

For information about COMSOL Server security, see the section Security in the 
COMSOL Server Manual.
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Troubleshooting License Errors

If you have questions or problems with your installation, start by checking the 
COMSOL Support Knowledge Base at www.comsol.com/support/
knowledgebase for up-to-date information about installation and license issues. If 
this does not help, then please contact COMSOL technical support at 
support@comsol.com.

THE COMSOL SUPPORT KNOWLEDGE BASE

The most important Knowledge Base entries for installation questions and license 
errors are the following:

You can also view videos about installation at: www.comsol.com/
videos?workflow%5B%5D=workflowstep-install.

LICENSE ERRORS

This section summarizes the most common postinstallation error messages 
generated by the COMSOL software, and it gives some advice how to 
troubleshoot them. For a complete list of error messages, see the FlexNet license 
manager documentation. This documentation is shipped with your COMSOL 
installation; see FlexNet® License Manager Documentation on where to find it.

SUBJECT KNOWLEDGE BASE ENTRY

Could not obtain license for 
COMSOL Multiphysics GUI

www.comsol.com/support/knowledgebase/903

Running COMSOL in parallel 
on clusters

www.comsol.com/support/knowledgebase/1001

Updating the COMSOL 
License Manager

www.comsol.com/support/knowledgebase/1022

COMSOL Installation 
Companion

www.comsol.com/support/learning-center/
article/comsol-Installation-Companion-58101

Error: An error has occurred. 
See the log file C:\Users...

www.comsol.com/support/knowledgebase/1083

Selecting hardware for 
clusters

www.comsol.com/support/knowledgebase/1116

Error: Error downloading file. 
Connection refused: connect

www.comsol.com/support/knowledgebase/1149
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If you need to review the license manager log file, or send it to COMSOL 
technical support, this is where you usually find it (depending on choices you 
made during the installation):
• Windows: C:\ProgramData\COMSOL\comsol64.log.
• macOS: /var/tmp/comsol64.log
• Linux: /var/tmp/comsol64.log

If you need to access the license file, this is where you usually find it:
• Windows: 

C:\Program Files\COMSOL\COMSOL64\Multiphysics\license\license.dat

• macOS: /Applications/COMSOL64/Multiphysics/license/license.dat
• Linux: /usr/local/comsol64/multiphysics/license/license.dat

ERROR MESSAGE EXPLANATION

License error A general license error has occurred. Check the error message for 
details that might help solve the problem. If you need help in 
interpreting the information, see the FlexNet license manager 
documentation or send the complete error message to 
support@comsol.com.

License error: -1. 
Cannot find license 
file.

The license file is missing or your system settings do not allow you to 
read the file. Review the license manager installation steps above and 
check that you have administrative rights on your computer.

License error: -2. 
Invalid license file 
syntax.

There is a formatting problem with your license file. This can happen if 
you edit it with a word processing software such as Microsoft Word 
which inserts extra (invisible) characters. Use a plain text editor 
instead (on Windows: Notepad, WordPad, or similar). Formatting 
problems can also happen if the file is damaged while being copied or 
emailed from one computer to another.

License error: -4. 
Licensed number 
of users already 
reached.

The license manager has detected that all available licenses of a 
certain COMSOL product have been used by other users. Contact 
your license administrator and report this problem. You might need 
more licenses of one of the add-on products.

License error: -5. 
No such feature 
exists.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages.

Please send the log file to support@comsol.com if you want help in 
interpreting the information.

NOTE: The license manager creates the log file. If there is no log file, 
make sure to first start the license manager. Please refer to one of the 
License Manager Installation sections of this manual for instructions 
how to install and start the COMSOL license manager.
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License error: -10. 
Feature has 
expired.

This error message indicates that you have a time-limited (trial) license 
and that your license has expired. Contact your license administrator 
to see if a more recent license file is available. You can also contact a 
COMSOL representative to renew your time-limited license.

License error: -12. 
Invalid returned 
data from license 
server system.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if that 
helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager, or the connection from the lmgrd daemon and the 
LMCOMSOL daemon.

If the problems remain, send the license manager log file to 
support@comsol.com.

ERROR MESSAGE EXPLANATION
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License error: -15. 
Cannot connect to 
license server 
system.

The license manager has not been installed or started yet. If the first 
line of your license.dat file looks like this:

SERVER mylicserver 000123456789 1718

a license manager is required. Please refer to the License Manager 
Installation sections of this manual for instructions on how to install 
and start the COMSOL license manager.

Check that no firewall on the COMSOL client is preventing the 
connection from the COMSOL client to the license server. 
Temporarily disable any firewall on the COMSOL client to see if that 
helps.

Check that no firewall on the license server is preventing the 
connection from the COMSOL client computer to the license 
manager.

Check that the license.dat file on the COMSOL client computer 
points to the correct license server hostname. First, find the 
license.dat according to the instructions above.

Check that the first line has the correct license server hostname. For 
example, if your license server hostname is apollo, the first row in 
the license.dat file should look like this:

SERVER apollo 000123456789 1718

If the COMSOL client computer does not recognize apollo as a 
proper hostname, it might help to instead use the fully qualified 
domain name (apollo.thecompany.com) or the IP address. If 
neither of these work, there might be a problem with DNS or the 
HOSTS file on the client. Please ask your system administrator for 
advice on how to connect with TCP/IP to the license server.

Finally, the license manager might have encountered a problem during 
startup. Check the license manager log file for error messages.

NOTE: The log file is created by the license manager after it has been 
started.

Please send the log file to support@comsol.com if you want help in 
interpreting the information.

For information about a loss of connection to the license server while 
running the COMSOL Multiphysics software, see License Server 
Interruptions below.

License error: -39. 
User/host not on 
INCLUDE list for 
feature.

The error means that your username does not match the one listed in 
the license manager options file, LMCOMSOL.opt. To get access to 
COMSOL, ask your license/system administrator for help. When the 
username in the options file is changed, the license manager must be 
shut down and restarted to give the new user immediate access to 
COMSOL.

ERROR MESSAGE EXPLANATION
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LICENSE SERVER INTERRUPTIONS

If the license server does not respond during a COMSOL Multiphysics session so 
that the COMSOL Multiphysics software cannot connect to the license server, 
you will see the following effects:
• The following error message appears after a few minutes:

Click Save and Exit to save the current COMSOL Multiphysics model and then 
exit, or click Exit to exit from the COMSOL Desktop without saving. You could 
also wait to see if the connection can be reestablished. If you choose to save the 
mode, you get a choice of location for the file. In addition, if there are models 
on the server that are not used by the COMSOL Desktop, they are saved 
immediately in their original locations with autosaved appended to their 

License error: -88. 
System clock has 
been set back.

The software has detected that a system clock has been set back.

Please make sure that your computer’s clock is set to the current local 
time and date. If the problem remains check that there are no files on 
your hard drive that have a future date.

License error: -96. 
License server 
machine is down 
or not responding.

Please make sure that the SERVER hostname in the license.dat 
file is valid and that the TCP/IP network connection between the 
application computer and the license server is working properly.

This error could also indicate that your firewall is not configured 
properly in order to let the license manager and vendor daemon 
network traffic through (typically ports 1718 and 1719). It could also 
indicate problems with other network security settings. Contact your 
systems administrator for help.

License error: -97. 
The desired 
vendor daemon is 
down.

The license manager has encountered a problem during startup. 
Check the license manager log file for error messages.

NOTE: The log file is created by the license manager after it has been 
started.

Please send the log file to support@comsol.com if you want help in 
interpreting the information.

ERROR MESSAGE EXPLANATION
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filenames in order not to overwrite the original files. Models that have never 
been saved are saved in the recovery folder also when recovery is not enabled. 
However, if there is no recovery file and the program has stopped when 
executing a runnable, it is not possible to save the model. If you are running a 
COMSOL batch job, the output file is used if it is not identical to the input file.

• As soon as the connection to the license servers has been lost, you will not 
be able to add feature nodes with license requirements to the Model Builder. 
Trying to add such nodes result in an error message such as “Could not 
obtain license for Floating Potential 1 {fb1}, Required product: AC/DC 
Module” and a license error -15 (see list of license errors above).
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Windows, client server and 72

Windows, cluster installation and 50

Windows, clusters and 75

Windows, definition 52

H hard disk serial number 17

hardware lock 15

host 75

hostid

Linux, changing licenses 115

Linux, Internet installations 102

macOS, changing licenses 92

macOS, Internet installations 79

Windows, changing licenses 66

Windows, Internet installations 17

Windows, license server and 55

I idle timeout 61

INCREMENT line, license file 56

installation

Linux 101

macOS 78

media options 9

previous 10

Windows 16

J Java runtime, custom 29

K Knowledge Base 9

COMSOL Access, and 15

troubleshooting 128
136 | 



L Learning Center 9

License Agreement 9

license agreement 11

license errors 128

license feature name 56

license file

comment line 55

example of 18

FEATURE line 56

FlexNet, and 14

INCREMENT line 56

macOS, obtaining 80

SERIAL line 56

SERVER line 55

troubleshooting 129

USE_SERVER line 55

VENDOR line 55

Windows, obtaining 17

license manager

automated installation on Linux 113

automated installation on macOS 89

automated installation on Windows 

63

daemon, Linux 110

daemon, macOS 87

daemon, Windows 53

files for installation, Linux 111

files for installation, macOS 88

files for installation, Windows 62

installing files, Linux 111

installing files, macOS 88

installing files, Windows 62

Linux, log file 113

Linux, starting 113

log file 65

log file, troubleshooting 129

macOS, log file 90

macOS, starting 90

Windows, log file 65

Windows, starting 64

license server

Linux, client server and 119

Windows, and 22

Windows, client server and 72

license, changing

Linux 115

macOS 91

Windows 66

license.dat

FlexNet, and 14

Linux 111

Linux, changing 115

macOS 87

macOS, changing 92

troubleshooting 129

Windows 54

Windows, FlexNet and 53

LiveLink for

AutoCAD 44

Autodesk Inventor 45

Excel 44

PTC Creo Parametric 46

Revit 47

Solid Edge 48

SOLIDWORKS 49

lmgrd.exe Linux 110

lmgrd.exe macOS 87

lmgrd.exe Windows 53

lmhostid

Linux 115

macOS 92

lmutil

Windows 66

lmutil Linux 110

lmutil macOS 87

lmutil Windows 53

log file, license manager 65

log file, Linux 113
 | 137



log file, macOS 90

log file, troubleshooting 129

log file, Windows 65

M MAC address

Linux installations 102

macOS installations 92

Windows installations 17, 66

MATLAB

Linux, changing path to 108

macOS, changing path to 84

running COMSOL Multiphysics on 

Linux with 122

running COMSOL Multiphysics on 

macOS with 94

running COMSOL Multiphysics on 

Windows with 76

Windows, changing path to 77

merged license file 24

multicore computing 11

multiprocessor computing 11

N Named Single User License

definition 12

Linux, and 105, 111

O operating system 11

options file 111

P passcode 16

physical address 17

port number 22

previous installation 10

product downloads 9

COMSOL Access, and 15

Linux 101

Linux, DVD 104

macOS 78

troubleshooting 128

Windows 16

Windows, DVD 19

product updates 9

COMSOL Access, and 15

proxy server

for software updates 41

Linux installations 108

macOS installations 84

Windows installations 28

PTC Creo Parametric

LiveLink for 46

R remove feature 21

Revit

LiveLink for 47

root 114

S SERIAL line, license file 56

SERVER line, license file 55

shared-memory computing 11

software license agreement 11

Solid Edge

LiveLink for 48

SOLIDWORKS

LiveLink for 49

system requirements 9, 10

T technical support, contacting 128

technical support, website 9

three-server redundancy 22

timeout, of licenses 61

trial license

Linux 102

macOS 78, 101

Windows 16

troubleshooting license errors 128

tutorials, installation 128

tutorials, videos 9

U uninstalling COMSOL

Linux 107

macOS 83

Windows 39

updates, product 9

COMSOL Access 15
138 | 



USE_SERVER line, license file 55

user interface, cross-platform 68, 70

utility program, Linux 110

utility program, macOS 87

utility program, Windows 53

V vendor daemon

Linux installations 110

macOS installations 87

Windows installations 53

VENDOR line, license file 55

videos

installation 128

tutorials 9

volume serial number 17

W web browsers, for Linux 106

X xterm program 122, 123
 | 139



140 | 


	Contents
	Before You Begin
	Installation Media Options
	System Requirements
	Previous Installations
	Software License Agreement
	License Types
	License Management Tools
	COMSOL Access

	Installing on Windows
	Installation over the Internet
	Downloading and Installing the COMSOL Software
	Installation from a USB Flash Drive
	Running the COMSOL Installer
	Removing (Uninstalling) the COMSOL Installation
	Installing Software Updates
	Automated Installation
	Product Updates and Library Updates
	LiveLink™ for Excel® Installations
	LiveLink™ for AutoCAD® Installations
	LiveLink™ for Inventor® Installations
	LiveLink™ for PTC® Creo® Parametric™ Installation
	LiveLink™ for Revit® Installations
	LiveLink™ for Solid Edge® Installations
	LiveLink™ for SOLIDWORKS® Installations
	Cluster Installation

	License Manager Installation on Windows
	What Is the FlexNet® License Manager?
	System Requirements for the FlexNet® License Manager
	FlexNet® License Manager Software Components
	FlexNet® License Manager Documentation
	The License File and The License Features
	Installing the License Manager
	Starting the License Manager
	Verifying That the License Manager Is Running
	Starting COMSOL Multiphysics
	Changing the License
	Using COMSOL on an IPv6 Network
	Troubleshooting License Errors

	Running COMSOL Multiphysics on Windows
	The COMSOL Multiphysics Folder on The Start Menu
	Starting COMSOL Multiphysics for a Classkit License
	Creating Desktop Shortcuts Manually
	Running COMSOL Multiphysics in Client–Server Mode
	Running COMSOL Multiphysics in Batch Mode
	Multicore Settings
	Running COMSOL Multiphysics on Clusters
	Running COMSOL Multiphysics on the Cloud
	Running COMSOL Multiphysics with MATLAB
	Running COMSOL Multiphysics with Simulink

	Installing on macOS
	Installation Over the Internet
	Downloading and Installing the COMSOL Software
	Installation from USB Flash Drive
	Running The COMSOL Installer
	Automated Installation
	Removing (Uninstalling) the COMSOL Installation
	Product Updates and Application Library Update
	Changing the Path to the MATLAB® Installation
	Cluster Installation

	License Manager Installation on macOS
	FlexNet® License Manager Software Components
	FlexNet® License Manager Documentation
	The License File
	Installing the License Manager
	Starting the License Manager
	Verifying That the License Manager Is Running
	Starting COMSOL Multiphysics
	Changing the License
	Using COMSOL on an IPv6 Network
	Troubleshooting License Errors

	Running COMSOL Multiphysics on macOS
	The COMSOL Applications
	Running COMSOL Multiphysics from a Terminal Window
	Running a Classkit License
	Running COMSOL on Clusters
	Running COMSOL Multiphysics in Client–Server Mode
	Running COMSOL Multiphysics in Batch Mode
	Multicore Settings
	Running COMSOL Multiphysics on Clusters
	Running COMSOL Multiphysics on the Cloud

	Installing on Linux
	Installation Over the Internet
	Downloading and Installing the COMSOL Software
	Installing from a DVD
	Installation from USB Flash Drive
	Running The COMSOL Installer
	Web Browser for Viewing Documentation and Help
	Automated Installation
	Removing (Uninstalling) the COMSOL Installation
	Product Updates and Application Library Update
	Changing the Path to the MATLAB® Installation
	Cluster Installation

	License Manager Installation on Linux
	FlexNet® License Manager Software Components
	FlexNet® License Manager Documentation
	The License File
	Installing the License Manager
	Starting the License Manager
	Verifying That the License Manager Is Running
	Starting COMSOL Multiphysics
	Changing the License
	Using COMSOL on an IPv6 Network
	Troubleshooting License Errors

	Running COMSOL Multiphysics on Linux
	Running COMSOL Multiphysics
	Multicore Settings
	Running COMSOL Multiphysics in Batch Mode
	Running COMSOL Multiphysics in Client–Server Mode
	Running a Classkit License
	Running COMSOL on Clusters
	Running COMSOL Multiphysics on the Cloud
	Running COMSOL Multiphysics with MATLAB
	Running COMSOL Multiphysics with Simulink

	COMSOL Security
	COMSOL Multiphysics Client–Server Security
	Application and Physics Builder Security
	Method Security
	COMSOL Server Security

	Troubleshooting License Errors

